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Getting Started

Purpose and scope
This guide is written primarily for those individuals responsible for implementing the 
MetaSolv Solution™ (formerly Telecom Business Solution™ ). The guide explains how, 
when, and why you modify, create, and use structured formats. This guide also makes 
recommendations for working with structured formats by following specific sequences 
and adhering to established guidelines. These recommendations constitute "best 
practices." While it is always considered best practice to refer to the online Help for field 
definitions, this guide also includes detailed, step-by-step instructions for certain tasks to 
clarify the sequence and values involved.

Using the MetaSolv Solution online Help
MetaSolv Solution includes comprehensive online Help. You access Help from the Start 
menu (where you installed the software) or from within the software by clicking the Help 
menu.

MetaSolv Solution online Help contains a main table of contents, a traditional book-like 
index, and a full-text search index. To access any of these, launch the Help as described 
above, then click the Help Topics button. The Help’s contents are on the Contents tab, the 
index is on the Index tab, and the full-text search index is on the Find tab.

Note: The first time you launch online Help, a message appears while the Help is 
prepared. The first time you launch a full-text search index, a wizard deploys to 
prepare the full-text index.
1994-2001 MetaSolv Software, Inc. 1
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Document conventions
The following conventions are used throughout this document to help you better identify 
important items:

Table 1: Document Conventions

Convention Description Example

Bold text Items you can click in the 
software, such as buttons, 
menu items, and fields

Click the New button.

Press F1 to access Help.

Select List>Location from the 
main menu.

Italics Places where you input 
information or select an 
item from a drop-down

Enter your name in the Name 
field.

Select TX from the State drop-
down.

Quotes Status The circuit is in "In Progress" 
status.

Step head Procedural steps follow this 
heading

N/A

Note N/A

Warning N/A

Cross-reference to a topic in 
the online Help

N/A
2 1994-2001 MetaSolv Software, Inc.
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Document Organization

Table 2: Document Organization

If you want to... See...

Understand why structured formats are used and how they are 
constructed

Chapter 2

Modify and create structured formats for address, switch prefix, and 
telephone number.

Chapter 3

Use structured formats Chapter 4

Learn how to contact Customer Support for assistance Appendix A
1994-2001 MetaSolv Software, Inc. 3
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Introducing Structured Formats

This chapter is primarily intended for implementers rather than users. References 
throughout this document to "you" are addressed to the individuals responsible for 
implementing the MetaSolv Solution: MetaSolv consultants, MetaSolv partners, and 
employees of the client who are members of the implementation team. This chapter is 
secondarily addressed to users (who are referred to as such, rather than as "you") who 
might also benefit from understanding the implementation issues regarding structured 
formats. This chapter explains the concepts underlying structured formats, and why best 
practices should be established and followed during implementation and throughout the 
ongoing use and maintenance of the software. 

This chapter includes the following sections:

What structured formats are

When and how structured formats are employed

The role of geographic areas and MetaSolv software processes

The base data loaded for structured formats

The role of components

Structured format implementation checklist

Primary list of best practices for structured formats

What structured formats are
Structured formats provide a way to enter, define and store structure and formatting 
information for addresses, telephone numbers, and switch prefixes. Since these 
information structures can vary from country to country, structured formats use 
geographic areas, MetaSolv Software processes, and industry version to provide the 
flexibility needed for setting up the appropriate structures. 

There are currently three types of structured formats loaded during installation of the 
software: address, telephone number, and switch prefix. For these three types of 
structured formats, there are several system-defined structured formats loaded as base data 
at installation. They are customized for different countries and specific standards, such as 
the National Emergency Number Association (NENA). 

It is from these system-defined structured formats that you choose the formats appropriate 
for a given client’s telephone numbers, switch prefixes, and addresses. It is also from these 
system-defined structured formats that you can create other structured formats for 
countries and client’s whose requirements are new and unique. 

Structured formats control how the fields, or components, of an address, telephone 
number, and switch prefix appear in the windows of the software. For example, the 
1994-2001 MetaSolv Software, Inc. 5
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components of a United States address are items such as street number, street name, state, 
and ZIP code. When a user enters an address into any area of the software that employs 
structured formats, the fields the user sees—how they are labeled, the order and position 
in which they appear on the window—is dictated by the structured format. It is incumbent 
upon you to implement structured formats appropriately so that users see what the client 
wants them to see.

For example, in the following figure you see the window in which a network location 
address is entered. All the field names on that window, the field types (drop-down, 
editable), and the sequence in which they appear are controlled by the structured format. 
In this particular window, you can also see which structured format is controlling it: North 
American Master Street Address Guide (MSAG). You also see the country that is 
associated with the structured format: United States. 

Figure 1: Example of MSAG Structured Format Controlling Address Fields

Prior to the deployment of structured formats, the appearance and content of an address, 
telephone number or switch prefix was system-defined and could not be customized. If a 
user needed to add a fourth line of address information, or two more digits to a phone 
number, it was done through some other means, such as Notes or Remarks. Now that 
MetaSolv serves a global community, the software accommodates the differing address, 
telephone number and switch prefix formats employed globally. Our clients can now 
determine exactly how the software prompts for and displays those values. 

Note that the 
structured format’s 
name is MSAG, but 
its description is 
North American 
Street Address 
Guide. It is the 
structured format’s 
description that 
appears in drop-
downs. 
6 1994-2001 MetaSolv Software, Inc.
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When and how the MetaSolv Software employs structured formats
Structured formats govern the appearance (windows) and content (components) of 
addresses, telephone numbers, and switch prefixes. Understanding when they are used, 
and how they are used is key to implementing them properly.

When structured formats are employed

Most of the areas that require an address, telephone number or switch prefix employ a 
structured format to both present and store the values entered by users through data entry 
windows. (The only addresses and telephone numbers that do not employ structured 
formats are those used for contacts, and those used in the Trouble Management and LSR 
modules.)

For example, when a user enters an address into a window, the fields on the window are 
dictated by the address structured format in use. If you look at Figure 1 on page 6, the 
fields on that window are being dictated by the structured Format North American Master 
Street Address Guide, and the Country United States. If you look at Figure 2 below, the 
fields on that window are dictated by the structured Format Address Format for Brazil and 
the Country Brazil. 

Figure 2: Example of a ADDR_BR Structured Format Controlling Address Fields

Notice that the selection of Address Format for Brazil dictates different fields from those 
dictated by the North American Master Street Address Guide format shown in Figure 1. 

Note: Clients who do not inventory telephone numbers do not need to define switch 
prefix or telephone number structured formats.

Note that the 
structured format’s 
name is ADDR_BR, 
but its description is 
Address format for 
Brazil. It is the 
structured format’s 
description that 
appears in drop-
downs on data entry 
windows. 
1994-2001 MetaSolv Software, Inc. 7
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Some of the field names, and the sequence and layout in which they are presented, are 
different.

In the two preceding examples, the structured formats were system-defined, including 
their association with Country. When the user of a Brazil or United States implementation 
opens a window that requires a structured format, one is available by default; the 
implementation team does not have to set up those structured formats or the relationships 
between geographic area types for those countries. However, if the implementation is in 
Canada, or England, or France, or any country other than the United States or Brazil, the 
user would receive an error message. There are several countries with system-defined 
structured formats, but only Brazil and the United States have system-defined 
relationships for their geographic area types. (Geographic area types and their role in 
structured formats are explained on page 17.)

Some countries have system-defined default structured formats established, some do not. 
Countries without defaults require careful planning, definition, construction, and 
refinement during implementation. It is important to understand which countries have 
defaults, and how structured formats are employed by the software before you begin the 
process of determining whether the client needs any modifications or additions to the 
default structured formats.

How structured formats are employed

Default structured formats are provided for the following countries when you install the 
software:

Belgium

Brazil

Canada (with English and French address formats)

France

Germany

Mexico

Portugal

United States

While you can modify the structured formats when a client’s business practices indicate 
that you should, you do not need to modify or add anything associated with structured 
formats in order to use them in the countries listed above. Likewise, you do not need to 
add or modify anything regarding geographic area types for these countries, though you 
will need to create geographic hierarchies for all countries except the United States and 
Brazil. (Geographic area types and geographic hierarchies are explained in the section 
titled, “Role of geographic area types” on page 17.)
8 1994-2001 MetaSolv Software, Inc.
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It is also important—critical—to understand that when you must add structured formats 
and geographic area types for a client, you should do so with thorough planning during 
implementation, and thorough testing prior to going live. 

To understand how structured formats are employed, you need to know the hierarchical 
process the software goes through to determine what structured format to use when a user 
enters an address, telephone number, or switch prefix. This hierarchical process is: 

1. Industry version (relevant only to countries using North American Functionality)

2. Process

3. Preferences

4. Country

The way the software determines what level in the hierarchy to use based on the following 
four checks:

1. Checks for industry version. 

If the call for a structured format comes from the regulated ordering module (ASR or LSR), 
then the software checks what type of structured format is being called for, and the 
industry version on the ordering guideline in effect. It then uses the structured format that 
has relationships to both the regulated ordering process (the ASR process or the LSR 
process) and the industry version. (ASOG 22 is the only industry version currently 
supported by structured formats.)

For example, if the user is entering an ASR that requires the Service Address Location 
Information (SALI) form, the software checks the list of available structured formats for 
one associated with the ASR process and the industry version of the ASR being entered. 
Currently, there is one structured format associated with both ASR and industry version: 
OBF_SRVC_ADDR, described as OBF Service Address Location Information. The 

Warning: You cannot make changes to a geographic area type, geographic area 
hierarchy, or a structured format after data is entered into the database. 
There is no automated means of migrating previously entered data to a new 
structured format, geographic area type, or geographic area hierarchy. A 
custom conversion would be required to migrate the old data to the new 
format. 
1994-2001 MetaSolv Software, Inc. 9
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following illustration (Figure 3) is of the structured formats window in the MetaSolv 
Solutions Utility Application. It shows a partial list of structured formats. 

Figure 3: Structured Formats Window in MetaSolv Solution Utility Application

When you open a structured format, you see five tabs. On the MetaSolv Solution Processes 
tab, you see the software processes associated with the structured format. On the Industry 
Version tab, you see the industry versions associated with the structured format. The 
10 1994-2001 MetaSolv Software, Inc.
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MetaSolv Solution Processes tab and the Industry Versions tab for the OBF_SRVC_ADDR 
structured format are shown in Figures 4 and 5. 

Figure 4: Processes Tab of OBF_SRVC_ADDR Structured Format

Figure 5: Industry Versions Tab of OBF_SRVC_ADDR Structured Format

2. Checks the process. 

If no industry version is present in the active process, then the software uses the structured 
format associated with the active process. If there are multiple structured formats 

The list of Processes shown in 
this pane is associated with 
(can use) the OBF_SRVC_ADDR 
structured format. 

The Industry Versions listed here 
are associated with (can use) the 
OBF_SRVC_ADDR structured 
format. 
1994-2001 MetaSolv Software, Inc. 11
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associated with that process (see Table 5 on page 20 for a list of processes), then the 
software finds the structured format associated with both the process and the user’s 
country. The software always knows the user’s country—either from the user selecting 
country on the data entry window, or from the user’s preferences, or from the operating 
system’s country code. If there are multiple structured formats to choose from for that 
country, then the software looks for the user’s preferences. If the relevant preferences are 
not set, the software uses the structured format with its Primary Indicator enabled. 

For example, if the user is entering a network location, the software finds all the address 
structured formats associated with the network location process (all the address structured 
formats that have NL_ADDR listed on their Processes tab). Because several address 
structured formats are associated with NL_ADDR, the software must find the structured 
format that is associated with both NL_ADDR and the user’s country. In the case of the 
network location being entered in the window shown earlier in Figure 2, the address 
structured format with relationships to both NL_ADDR and Brazil is ADDR_BR. The 
following illustration (Figure 6) shows the Countries tab of the ADDR_BR structured 
format, with Brazil as the only related country.

Figure 6: Countries Tab of ADDR_MX Structured Format

The country(s) listed here are 
associated with (can use) the 
structured format. In this 
example, Brazil is the only 
country associated with the 
ADDR_BR structured format. 
12 1994-2001 MetaSolv Software, Inc.
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3. Checks preferences. 

If the software is unable to determine the correct structured format after checking industry 
version and process, then it checks the structured formats specified in preferences. (Note 
that when specifying preferences, you must specify the Country preference before the 
structured format preferences.) If the structured format preferences are specified, then the 
software uses those structured formats for the activity requesting them. 

For example, in the following illustration (Figure 7) you see the preferences for Address, 
Switch Prefixes and Telephone Numbers set to Mexico.

Figure 7: Structured Format Defaults in Preferences

4. Checks the default structured format for the country. 

If the industry version, process, and preferences have failed to produce a structured format 
for the given situation, then the software uses the default structured formats for the user’s 
country. This is determined by finding the structured format associated with the user’s 
country, where the structured format is checkmarked as Primary for that country. The 
user’s country can always be ascertained, even if the preference for Country is not set 
because the software can get the country code from the operating system of the user’s 
machine. 

For example, in Figure 8 on page 14, you see that the MSAG structured format is the 
default address structured format for the United States and Brazil because the Primary 
Indicator checkbox is checked for both countries on that structured format’s Countries tab. 
Note that for a given country, only one address structured format can be primary. For a 
given country, there can be only one telephone number and one switch prefix structured 
format, and that one is, by default, primary.

For example, the United States can be associated with the MSAG, OBF_SRVC_ADDR, and 
TEXT address structured formats, but the Primary Indicator checkbox for the United 
States can be checkmarked on only one of those address structured formats.
1994-2001 MetaSolv Software, Inc. 13
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Figure 8: Default Address Structured Format Determined by Primary Indicator for Country

The countries with system-defined structured formats are listed below in Table 3. An 
asterisk (*) denotes whether the structured format is primary for that country. 

It is important to note that the primary address structured format is the default, but it is not 
the only structured format users can select from if there are multiple address formats for 
the country. Users can still select from all of the structured formats associated with the 
country, but the default (or their preference) is what appears in data entry window drop-
downs. 

It is also important to note that if the system-defined default is not what the client wants, 
the default can be changed. The process for changing it is explained in the next chapter.

Primary Indicator, when 
checkmarked, indicates 
default structured 
format for that country.
14 1994-2001 MetaSolv Software, Inc.
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Table 3: Default Structured Formats by Country

If you are implementing the MetaSolv Solution in a country other than those listed above, 
you and the client must determine which structured format to use for address, telephone 
number, and switch prefix. If the system-defined structured formats do not suit the client’s 
needs, you must either modify the existing structured formats, or create new ones. The 
system-defined structured formats are designed to accommodate the address, telephone 
number, and switch prefix formats of the above-listed countries in a generic way; for 
clients who do not fit the generic model (such as Canadian clients who want to use MSAG, 
or United States clients who do not) you must carefully analyze and define appropriate 
structured formats.  

If your analysis of the client’s requirements indicates a need to create new structured 
formats, it is recommended that you use New-From functionality to create them. Creating a 
new structured format from an existing one preserves the relationship of processes to the 
structured format, the table and column assignments for the database, and the 
relationships between components. Once you create the new structured format using New-
From, you can add and delete components, and change the names and sequence of fields 
on the inherited components fairly easily. However, if you create a completely original 
structured format using New instead of New-From, accurately building the relationships 
and database assignments can be challenging. Furthermore, if the relationships and 
database assignments are done incorrectly, the corrective action could be costly.

It is also recommended that you use only one address structured format per country. The 
software prevents you from using more than one switch prefix and one telephone number 

Country
Address structured

format
Telephone Number 
structured format

Switch Prefix 
structured format

Belgium ADDR_BE TN-BE* SWITCH-BE*

Brazil ADDR_BR TN-BR* SWITCH-BR*

Canada ADDR_CA_ENG
ADDR_CA_FR

TN-US* SWITCH-US*

France ADDR_FR not defined not defined

Germany ADDR_DE* TN-DE* SWITCH-DE*

Mexico ADDR_MX* TN-MX* SWITCH-MX*

Portugal ADDR_PT not defined not defined

United States MSAG* TN-US* SWITCH-US*

Note: Clients that do not use the telephone number inventory do not need to define 
switch prefix or telephone number structured formats.
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structured format per country, but you can have multiple address structured formats per 
country. There are clients who will want to use more than one address structured format, 
and their reasons for doing so should be analyzed carefully. It is possible to do so, and it is 
warranted for some business processes, but it should not be done unless the business 
reasons are well thought out, and both the benefits and consequences are fully understood. 

For example, there could be a client in Canada who has 28 PSR order entry people in 
Montreal, and 36 PSR order people in Vancouver. The client wants the western addresses 
to be in the Canadian-English format (ADDR_CA_ENG), and the Eastern addresses to be in 
the Canadian-French (ADDR_CA_FR) format. This requires you to relate the PSR processes 
and the country Canada to both the ADDR_CA_FR and ADDR_CA_ENG address structured 
formats. It also requires you to set the users’ address structured format preference 
appropriately. For the 36 Vancouver users, you would click Preferences>User 
Preferences>Geo Areas>Address Structured Format=ADDR_CA_ENG, and for the 28 
users in Montreal you would set it to ADDR_CA_FR. 

If you do not set these users’ preferences, they can still select the appropriate address 
structured format from the address drop-down on the relevant window; however, the 
address format that appears by default might not be the correct one for them. Remember 
that only one address structured format can have the Primary Indicator enabled for a 
given country. 

In the Canadian example, if the users’ preferences are left unspecified (Address Structured 
Format=none), the software defaults to the structured format where the Primary Indicator 
for Canada is checkmarked, which might not be the right address format for the given user. 
If ADDR_CA_ENG is the address format with the Primary Indicator enabled for Canada, 
then that is the format that appears by default in all users’ windows in the absence of 
individual user preferences settings for address structured format. (Remember the 
hierarchy the software goes through to determine which structured format to employ: 1. 
Industry Version, 2. Process, 3. Preferences, 4. Country.)

Thus, in implementations using multiple address structured formats per country, when 
preferences are not set, the users must be diligent in checking that the correct address 
format is in use for the data they are entering. In the Canadian example, unless they set 
their individual user preferences for address structured formats, the Montreal users would 
not be seeing the right format by default. They would have to select the ADDR_CA_FR 
format from the drop-down because the default would be ADDR_CA_ENG. For this reason, 
it is strongly recommended that you set the user preferences appropriately for all users 
during implementation. Leaving this activity to the users’ responsibility post-
implementation is not recommended.

While this example presents a legitimate use of two address formats for one country, it 
presents the possibility of a potentially serious performance impact when querying for an 
address. A query will be slower when multiple formats are involved. The possibility of 
failing to specify the query correctly is also much greater when multiple structured 
formats are involved because the user must know which structured format applies to the 
data they are querying, and they must know the components of each structured format. 

In situations where a client believes they require multiple address formats, it might be 
better to define a structured format that is less granular in its component definitions so 
16 1994-2001 MetaSolv Software, Inc.
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that one structured format can accommodate all the different types of addresses the client 
needs. 

There are two very generic system-defined address structured formats that are designed 
specifically to fill this need. They are named ADDR_GENERIC_PC_CITY_ST, and 
ADDR_GENERIC_PC_CITY. ADDR_GENERIC_PC_CITY_ST includes three address lines, 
city, state, postal code and country. ADDR_GENERIC_PC_CITY includes three address 
lines, city, postal code and country. These two generic address formats might 
accommodate several international and data clients’ needs because of their simplicity and 
non-granularity. 

If the generic nor the other system-defined address formats meet the client’s needs, then a 
new address format should be created. There are a total of 27 columns in which to store 
address components. This quantity of components should be more than adequate to 
accommodate any type of address structured format any client requires. 

Role of geographic area types
As described earlier, the process the software goes through to select the appropriate 
structured format for a given situation relies in part on the relationship of structured 
formats to geographic areas. COUNTRY is the highest level geographic area type (GAT) 
used in structured formats at this time. If you are implementing the software in a country 
other than those listed in Table 3, you and the client must determine what to use for the 
GATs subordinate to COUNTRY, and you must define the relationships that exist between 
those GATs. Defining the relationships between GATs is also referred to as building the 
GAT hierarchy. The only countries for which you do not have to build a GAT hierarchy 
are the United States and Brazil.

The base data loaded at installation includes six system-defined GATs. COUNTRY is an 
example of a GAT, and Belgium is an example of an instance of that GAT. Likewise, 
STATE is an example of a GAT, and Texas is an example of an instance of STATE. (With 
the exception of instances of countries, the instances of GATs must always be added 
through Infrastructure as part of the implementation process—instances of GATs lower 
than country are never included as base data.) If the base data GATs do not suit the client’s 
needs, you must create new ones. For all countries other than the United States and Brazil, 
you must define the hierarchy that relates each GAT within the country, whether that GAT 
is new, or system-defined. The system-defined GATs loaded as base data are listed 
alphabetically in the following table, along with brief descriptions of their possible 
hierarchical relationships to each other.
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Table 4: System-defined GATs Loaded as Base Data

If the system-defined GATs do not accommodate your client’s country, and you need to 
create new GATs, you do so using New functionality. The software provides a pre-defined 
relationship to the COUNTRY GAT for the majority of countries. When you need to create 
a new GAT it is most often a GAT that is subordinate to COUNTRY. 

For example, Japan has a GAT called prefecture, but prefecture is not one of the system-
defined GATs. If you were implementing a client in Japan, you would need to create a 
GAT called PREFECTURE and relate it as a child to the COUNTRY Japan. Though the 
situation is unlikely, if you need to relate a new country to the COUNTRY GAT, you can. 
Creating a new country is a slightly different procedure than creating a new GAT that is 
subordinate to COUNTRY. The procedures and nuances of creating new GATs, including 
creating new countries, are explained in the next chapter.

Processes that can be associated with structured formats

Just as multiple countries can be associated with one structured format, multiple processes 
can be associated with one structured format. Processes, as the term is used within 
structured formats, are specific areas of functionality with the MetaSolv Solution. 

For example, the PSR500 process is all the functionality within the PSR module that uses 
structured formats and geographical areas, except the parts of PSR that employ service 

GAT Description and Relationships

CITY CITY is a system-defined GAT that is often related as a child to 
STATE and COUNTRY. For the United States and Brazil, CITY has a 
system-defined relationship as a child to parent GAT STATE. 

COLONIA COLONIA is a system-defined GAT that is often related as a child to 
TOWN for Mexico and other Spanish-speaking countries.

COUNTRY COUNTRY is the highest level system-defined GAT currently used in 
GAT hierarchies. COUNTRY is often related as the parent to STATE, 
PROVINCE, and CITY. For the United States and Brazil, COUNTRY 
has a system-defined relationship as the parent to GAT STATE. 

PROVINCE PROVINCE is a system-defined GAT that is often related as a child to 
COUNTRY.

STATE STATE is a system-defined GAT that is often related as a child to 
COUNTRY. For the United States and Brazil, STATE has a system-
defined relationship as child to COUNTRY, and as parent to CITY.

TOWN TOWN is a system-defined GAT that is often related as a child to 
COUNTRY.
18 1994-2001 MetaSolv Software, Inc.
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addresses. The PSR functionality that uses service addresses is a separate process named 
PSR_SVC_ADDR. 

Looking at processes from the perspective of the structured formats that use them, 
consider the following example. The only process in which switch prefixes are used is the 
Infrastructure for Network Areas process (INFRA500NA). When you open the switch 
prefix structured format named SWITCH-MX, you see on the Processes tab that those are 
the two processes that are associated with the SWITCH-MX structured format. 

Figure 9: Example of Processes Related to a Structured Format

Processes are system-defined and loaded as base data. You cannot create, delete, or modify 
processes. You cannot modify the relationships of processes to system-defined structured 
formats. You cannot modify the relationships of processes to structured formats that are 
already in use (data has been stored using them.) You can modify the relationships of 
processes to structured formats in the structured formats you create, but you must be 
careful to relate them appropriately. The following table (Table 5) lists the system-defined 
processes that can be associated with a new structured format.

Note that the Assign buttons
are grayed-out because Pro-
cesses cannot be modified or
deleted on system-defined
structured formats. They
cannot be modified or delet-
ed on structured formats
that are already in use ei-
ther. 
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Table 5: Processes that Can Be Related to Structured Formats

Process Code Description

ASR22 Process for end-user service address location information (SALI) 
within ASR. This process should never be associated with new 
structured formats.

CC500 Process for querying for service requests within the Customer Care 
module. For an address structured format to be available in a 
Customer Care query, this process must be associated with that 
structured format.

INFRA500EU Process for end-user location window in Infrastructure.  For an 
address structured format to be available from the End User 
Location window in Infrastructure, this process must be associated 
with that structured format.

INFRA500NA Process for Network Areas, Number Inventories, and Prefix in 
Infrastructure. This is the only process that should be associated 
with a switch prefix structured format. 

PSR500 Process for telephone number processing and telephone number 
assignment in PSR. For a telephone number structured format to be 
available to assign telephone numbers in PSR, this process must be 
associated with that telephone number structured format.

ISR_SVC_ADDR Process for end-user service addresses in ISR. For an address 
structured format to be available in ISR for end user locations, this 
process must be associated with that structured format.

NL_ADDR Process for entering network location addresses on the Network 
Location window in Infrastructure. For an address structured 
format to be available in the Network Location window in 
Infrastructure, this process must be associated with that structured 
format.

The addresses for network locations are sometimes simpler (due to 
CLLI codes and Coded Locations) than end-user and service 
addresses. For that reason, network location addresses are grouped 
into this process, and end-user and service location addresses for 
Infrastructure are grouped into the INFRA500EU process. 

PSR_SVC_ADDR Process for end-user addresses in PSR. For an address structured 
format to be available in PSR for end user service locations, this 
process must be associated with that structured format. 
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System-defined structured formats
As already mentioned, the software provides several system-defined structured formats 
with the base data loaded during installation. The following tables list the 26 system-
defined structured formats, sorted by type, along with a brief description and a list of the 
components that comprise them. (Components are explained in the next section and in 
Chapter 3.)

Structured Format Name Description

ADDR_BE Format for Belgium. Components: Address Line, City, 
Country, Postal Code, Street Name, Street Number, 
Street Type.

ADDR_BR Format for Brazil. Components: Address Line, City, 
Country, Postal Code, State, Street Name, Street 
Number, Street Type.

ADDR_CA_ENG Format for Canada for English language. Components: 
Address Line, City, Country, Postal Code, Province, 
Street Name, Street Number, Street Type.

ADDR_CA_FR Format for Canada for French language. Components: 
Address Line, City, Country, Postal Code, Province, 
Street Name, Street Number, Street Type.

ADDR_DE Format for Germany (Deutschland). Components: 
Address Line, City, Country, Postal Code, Street Name, 
Street Number, Street Type.

ADDR_FR Format for France. Components: Address Line, City, 
Country, Postal Code, Province, Street Name, Street 
Number, Street Type.

ADDR_GENERIC_PC_CITY Generic three-line format without State. Components: 
Address Line 1, Address Line 2, Address Line 3, City, 
Country, Postal Code.

ADDR_GENERIC_PC_CITY_ST Generic three-line format with State. Components: 
Address Line 1, Address Line 2, Address Line 3, City, 
State, Country, Postal Code.

ADDR_MX Format for Mexico. Components: Address Line, 
Colonia, Country, Postal Code, State, Street Name, 
Street Number, Town.
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Table 6: Address Structured Formats Loaded as Base Data

ADDR_PT Format for Portugal. Components: Address Line, City, 
Country, Postal Code, Street Name, Street Number, 
Street Type.

LOT_BLOCK_PLAN Format for residential areas under construction. 
Components: Block, Lot Plan

MSAG Format for North American Master Street Address 
Guide used for NENA validation. Components: 
Additional Address, Building, City Name, Community, 
Country Code, County, Floor, House Number Prefix, 
House Number, House Number Suffix, Post 
Directional, Pre Directional, Room, State Code, Street 
Name, Street Suffix, Suite, Zip Code.

OBF_SRVC_ADDRESS Format currently used forOBF ASOG 22 Service 
Address Location Information form. Components: 
Address Format Type, Address Number, Address 
Number Prefix, Address Number Suffix, City, Country, 
Location Designator #1, Location Designator #2, 
Location Designator #3, Location Value #1, Location 
Value #2, Location Value #3, State/Province, Street 
Directional Prefix, Street Direction Suffix, Street Name, 
Street Type, ZIP/Postal Code.

RESERVE_LAND_HOUSE Format for rural areas. Components: House, Land, 
Reserve.

ROUTE_POLE Format for rural, undeveloped areas. Components: 
Pole, Route.

TEXT Format for areas requiring minimal or highly variable 
descriptions. Components: City, Country, Postal Code, 
State, Text.

Structured Format Name Description
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Table 7: Telephone Number Structured Formats Loaded as Base Data

Table 8: Switch Prefix Structured Formats Loaded as Base Data

Structured 
Format Name

Description

TN-BE Telephone number format for Belgium. Components: Area Code, 
Subscriber Line.

TN-BR Telephone number format for Brazil. Components: Area Code, Prefixo, 
Numero.

TN-DE Telephone number format for Germany. Components: Area Code, 
Subscriber Line.

TN-MX Telephone number format for Mexico. Components: Area Code, 
Subscriber Line.

TN-US Telephone number format for the United States. Components: Line, 
NPA, NXX.

Structured 
Format Name

Description

SWITCH-BE Switch prefix format for Belgium. Component: Area Code.

SWITCH-BR Switch prefix format for Brazil. Components: Area Code, Prefixo.

SWITCH-DE Switch prefix format for Germany (Deutschland). Component: Area 
Code.

SWITCH-MX Switch prefix format for Mexico. Component: Area Code.

SWITCH-US Switch prefix format for the United States. Components: NPA, NXX.
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Role of components
Components are the building blocks of structured formats. When you look at the MetaSolv 
Software through the windows of its user interface, the individual components of a 
structured format are seen as fields. Fields have a label, a type, a length, and other 
properties, as do components. 

For example, when a user looks at the data entry window (shown in Figure 10) for entering 
a new network location address into Infrastructure, they see two panes: one for selecting 
the country and address format, and one for entering the actual fields of the address. In the 
first pane they see that the country is United States and the address structured format is 
North American Master Street Address Guide. In the address information pane, they see 18 
fields, each with a label identifying the field. Some of the fields are drop-downs, some are 
editable. Each field is a component on the MSAG address structured format. The 
component defines where the field appears on the data window, what the field is called, 
how long it is, what type it is (drop-down or editable), and the order the cursor follows 
when the user presses the tab key to move from field to field

Figure 10: Network Location Data Entry Window

Editable field; value derives from 
what user types into the field.

Drop-down 
field; values 
presented 
derive from a 
table in the 
database.
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To see a list of the components driving the fields you see on the Network Location data 
entry window, you would open the Components tab of the MSAG structured format, as 
shown in Figure 11.

Figure 11: Components of the MSAG Structured Format

To see the properties that comprise an individual component, you would open a 
component from the Components tab. The Street Suffix component is opened in Figure 12. 
(You learn about component properties in detail in the next chapter.)

Figure 12: General Properties of a Component
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To understand components at a high level, remember that when a user views a window 
that employs a structured format, the fields he sees on the window are defined by the 
components of that structured format. Every structured format has at least one component, 
and every component includes the following:

Properties. A component’s properties include all aspects of its content, appearance, 
and function. The fields you see on the General tab in Figure 12 combine to define 
what the component is, what it is called, what values are entered into it, where it 
appears on a data entry window, what it looks like when built, and where it is stored 
in the database. 

Component Type. A component can be one of four types. The types have implications 
for where a component’s data comes from when it is displayed in a drop-down field. 
Knowledge of the MetaSolv Software data model, as it relates to structured format 
types, is essential for properly creating components. The four component types are:

⇒ Table Driven Drop Down drop-down. This component type is used for telephone 
number and switch prefix structured formats only, and it identifies the component 
as a drop-down. You must define the table and column in which a table-driven 
component is stored, and the table and column from which it is retrieved for 
presentation in the drop-down. The tables are not necessarily the same. For 
example, an NPA_NXX component is retrieved from a table called NPA_NXX , but 
stored in a table called TEL_NUM_INVENTORY.

⇒ Geographical area. This component type is used for address structured formats 
only, and it identifies the component as a drop-down. You must define the column 
in which geographical area components are stored, and the table and column from 
which they are retrieved for presentation in the component’s drop-down. For 
example, the component called City is stored in the column called 
GA_INSTANCE_CITY, in the table called ADDRESS. However, it is retrieved from 
the column called GA_INSTANCE_ID in the table called GA_INSTANCE. 

⇒ Valid Value drop-down. This component type is currently used for address 
structured formats only. You must define the column in which a valid value 
component is stored, however you do not have to define the table and column 
from which valid values are retrieved for presentation in the component’s drop-
down. Currently, the standard United States postal codes for street pre-direction 
and post-direction (compass points such as N, E, W, NE, and so forth), and street 
suffixes (also known as thoroughfare abbreviations, such as St., Blvd., Ave.) are the 
only system-defined valid values supplied as base data. You can create, delete and 
deactivate valid values, and you can select specific valid values for an address 
structured format. 

Furthermore, on regulated orders only, valid values can be associated with a 
specific provider using the provider’s Interexchange Customer Service Center 
(ICSC) code. For example, if a client sends ASRs to a provider who only accepts 
three-character street suffixes on service location addresses (they accept AVE but 
reject AV) then that provider’s ICSC can be associated with the three-character 
street suffixes only. 
26 1994-2001 MetaSolv Software, Inc.
Information subject to change without notice. MetaSolv confidential. All rights reserved.



Structured Formats Best Practices Guide
MetaSolv Solution™ M/5 Introducing Structured Formats
⇒ Not applicable. This component type identifies the component as one used for 
straight data entry. It is stored in the table and column you designate when you 
define it. 

Relationship to other components. If a component’s values are dependent on another 
component’s values, that relationship has to be defined. There are three types of 
relationships that can exist between components:

1. Component hierarchy

2. Geo Area hierarchy

3. Switches-to-telephone numbers

A Component Hierarchy relationship is used when the values one component presents 
are dependent on another component. For example, on a switch prefix structured 
format that uses North American Functionality, the values presented in an NXX drop-
down are dependent on what is entered into the NPA drop-down. Therefore, the NPA 
component must be related as a parent to the NXX component through a Component 
Hierarchy relationship. 

A Switches-to-Telephone Number relationship is used to relate a switch prefix 
structured format to a telephone number format. For example, the NPA component on 
the SWITCH-US structured format is associated with the NPA component on the TN-
US structured format. An illustration of the Component Hierarchy relationship and the 
Switches-to-Telephone Number hierarchy relationship is shown in Figure 13.
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Figure 13: Component Hierarchy and Switches-to-Telephone Number Relationships

A Geo Area relationship is used when one Geographic Area type component is dependent 
on another Geographic Area type component for filtering its values. For example, the City 
component is typically dependent on the State component to filter its values. Just as GATs 
define the hierarchy for a country through their relationships to one another, a Geo Area 
relationship define the dependency of one Geographic Area type component to another. 

If the client is upgrading

For existing customers upgrading to M/5, all address data affected by structured formats 
will be converted to the MSAG address format. Because of this conversion, the MSAG 
structured format cannot be altered in any way by clients who upgrade. If the client 
chooses to modify the MSAG format, you will need to do a New-From on the existing 
format, name it differently ("MSAG2" or "MSAG-NEW") and make modifications to the 
new format. 

Telephone Number
Structured Format
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Component 1:
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Component 2:
TN Exchange Code
(for example, NXX)
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Structured formats implementation checklist
Based on the information about structured formats introduced in this chapter, consider the 
following checklist as a high-level outline of what you should evaluate and define during 
implementation in regard to structured formats.

1. List the countries in which the client conducts business on a regular basis.

2. Research and thoroughly define the geographical areas that comprise those countries.

3. Relate the geographical areas hierarchically to one another. Consider that not all 
geographical areas are necessarily relevant to the client’s business, and that they might 
be relevant in some situations but not in others. For example, the United States has 
counties as geographical areas, but they are not used in postal address formats; they 
are, however, used in the MSAG. Or, as another example, like the United States, 
Germany has states, however they do not use states in addresses. Compare the client’s 
geographical hierarchy to the pre-loaded countries and GATs in the software and 
determine whether any changes or additions are required. Get a list of instances of 
each type of GAT so that you can enter them into Infrastructure (you will need some 
instances to be able to fully test the address structured formats).

4. Research thoroughly and define in detail the official postal address formats of the 
countries in which the client conducts business. Consider that the amount of detail 
needed for some types of addresses (such as service address locations) might differ 
from the amount of detail needed for other types of address (such as equipment 
locations). You must determine if there are business processes that require detailed 
address components. For example, NENA (E911) processing in the United States 
requires the components of the MSAG address format. 

5. Define the technically correct format for switch prefix within the technically correct 
format for telephone number. 

6. Examine the system-defined structured formats to determine if any of them fully 
accommodate the address, switch prefix, and telephone number formats the client 
requires. This step requires you to compare, component by component, the client’s 
requirements to the system-defined structured formats. 

7. Define in detail what the components will be for any structured formats that need to be 
modified or created. This includes defining the following:

⇒ Which components are mandatory fields on the data entry window.

⇒ Which components are drop-down fields on the data entry window.

⇒ Which components can be used in queries, and whether they are required.

⇒ How the components should be arranged on the data entry window as fields.

⇒ How the components should appear when they are displayed in a window as a 
built structure.

Note: Clients that do not use the telephone number inventory do not need to define 
switch prefix or telephone number structured formats.
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8. Write an implementation plan for structured formats based on the discoveries of this 
checklist.

Primary list of best practices for structured formats
The following list is preliminary and high-level. As you read the next chapters on how to 
modify, create and use structured formats, there are more detailed best practices to be 
considered.

When existing structured formats are not suitable to the client’s requirements, 
endeavor to create new structured formats using New-From functionality. New-From 
functionality ensures that hierarchies and relationships remain intact and correct. 
Creating new structured formats using New rather than New-From requires additional, 
thorough testing of hierarchies and relationships.

Ensure that there is always one structured format of a given type for a given country 
with its Primary Indicator enabled. The software prevents you from making a country 
primary on more than one structured format of each type, but it does not prevent you 
from omitting a Primary Indicator for a given structured format type and country. If 
the Primary Indicator is omitted for a given structured format type and country, there 
is no default structured format value for that country.

Clients should endeavor to use one structured format type per country throughout 
their software implementation, and these structured formats should not be 
fundamentally changed after they have been used. Cosmetic changes to the structured 
format description, or the components’ labels or sequence are not fundamental, and 
can be done. Changes to the number of components or to their type are fundamental, 
and should not be done. There is no method of upgrading the data stored with the old 
structured format after it is fundamentally changed. 

Clients who elect to use multiple address structured formats must understand the 
potential for slower queries, and for incorrectly specifying a query.
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Creating Structured Formats

This chapter is for the individuals responsible for implementing the MetaSolv Solution. 
As with the preceding chapter, however, advanced users of the software can also benefit 
from understanding the concepts and procedures presented in this chapter. 

This chapter explains how to create GATs and build a GAT hierarchy, and how to modify 
and create structured formats and their components to suit unique requirements. The 
chapter presents two types of information: scenarios and procedures. The scenarios 
present situations that lead to specific procedures. The procedures present how-to 
information for accomplishing specific tasks related to structured formats. The sequence 
in which you need to complete procedures varies with each implementation, but at the 
highest level, structured formats should be implemented in the following sequence:

Implementation Sequence

1. Build the GAT hierarchy

Activate country (in extremely rare cases, you might also have to add the country)

Add GATs if necessary, then relate GATs (build GAT hierarchy)

Add instances of GATs through Infrastructure

Set users’ preferences

2. Establish address structured format(s)

Determine which structured format to use, or to use as origin in New-From

Relate country, processes, and components, then activate structured format

3. Establish switch prefix structured format (if client uses telephone number inventory)

Determine which structured format to use, or to use as origin in New-From

Relate country, processes and components, then activate structured format

4. Establish telephone number structured format (if client uses telephone number 
inventory)

Determine which structured format to use, or to use as origin in New-From

Relate country, processes and components, then activate structured format

5. Relate switch prefix components to telephone number components 

There are more than five procedures required to complete the above five steps. The high-
level outline at the end of the preceding chapter, "Structured formats implementation 
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checklist" on page 29 can help you determine which procedures you need. Reading 
through the scenarios that begin on page 2 of this chapter can also help you determine 
which procedures you need. The list below shows the names and page numbers of all of 
the procedures included in this chapter. Note that some procedures include sub-
procedures; for some clients you might need only the sub-procedures, but for others you 
might need the entire procedure. 

Procedures

Determine GAT hierarchy (page 35)

Build a GAT hierarchy (page 40)

Add a new GAT (page 37)

Add a new country (page 37)

Activate a country (page 38)

Create instances of a GAT (page 39)

Define users’ preferences (page 39)

Determine the default structured formats for a country (page 41)

Determine structured formats that fit a client’s needs (page 41)

Change the default structured format for a country (page 42)

Modify an existing structured format (page 43)

Change component label (page 44)

Change component layout and tab sequence (page 44)

Change other properties of existing components (page 47)

Create a new address structured format (page 48)

Create a new switch prefix structured format (page 52)

Create a new telephone number structured format (page 54)

Create a component (page 58)

Create a Geographical Area component (page 59)

Create a Table Driven Drop Down component (page 66)

Create a Valid Value Drop Down component (page 71)

Add instances to the valid values table (page 74)
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The scenarios
The following scenarios are provided to help you understand the process of implementing 
structured formats and using the procedures that follow the scenarios. The scenarios also 
give you some basic data with which to practice implementing structured formats. 

The SpeedLink Inc. scenario
SpeedLink Inc. is a service provider in the United States that sells highspeed facilities 
exclusively to other providers. SpeedLink uses ISR and PSR for all their ordering. The 
only address information they want their users to be required to fill in on an order is the 
street address, city, state, and ZIP code. SpeedLink does not provision to end users or 
assign telephone numbers, so they do not need MSAG information on any address. 

Implementation analysis regarding the GAT hierarchies and structured formats reveals the 
following information about SpeedLink. Based on this information and the referenced 
procedures, you should be able to set up the needed GATs and structured formats.

The system-defined GAT hierarchy for country=United States is Country>State>City, 
which fulfills SpeedLink’s needs. 
(For instructions on determining geographic area hierarchy, see "Determine GAT 
hierarchy" on page 35.)

The default address structured format for Country=United States is MSAG, which does 
not meet SpeedLink’s needs.
(For instructions on determining the default structured format for a country, see 
"Determine the default structured formats for a country" on page 41.)

The address structured format that fits SpeedLink’s needs is TEXT.
(For instructions on determining structured formats that fit a client’s needs, see 
"Determine structured formats that fit a client’s needs" on page 41.)

Changing the default address structured format from MSAG to TEXT fulfills the needs 
of SpeedLink Inc.
(For instructions on changing the default structured format for a country, see the 
"Change the default structured format for a country" on page 42.)

The ManxComm Ltd. scenario
ManxComm is a data provider in Castletown, Isle of Man. They just purchased the 
MetaSolv Solution, primarily for its ordering, work management, and circuit design 
capabilities. As a data provider, they do not need to place any telephone numbers in 
inventory.

Implementation analysis regarding the GAT hierarchies and structured formats reveals the 
following information:

There is no instance of Isle of Man as a country, hence, there is no GAT hierarchy 
associated with Isle of Man. This is one of the very rare cases in which the country 
must be added. The Isle of Man lies between England and Ireland, but is not part of the 
United Kingdom. The system-defined GATs are suitable to Isle of Man’s hierarchy, but 
the country needs to be added and the GATs need to be related to each other. Isle of 
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Man’s hierarchy is simply COUNTRY as parent to CITY. (See "Add a new GAT" on 
page 37, and "Build a GAT hierarchy" on page 40 for instructions.)

There are no system-defined address structured formats for Isle of Man. (ManxComm 
does not need switch prefix or telephone number structured formats because they do 
not inventory telephone numbers.) The implementation team must research the 
system-defined address structured formats to determine which one to use, or create a 
new address structured format. (See "Determine structured formats that fit a client’s 
needs" on page 41, and "Create a new address structured format" on page 48 for 
instructions.)

The address format that ManxComm wants to use is shown in the table below. The 
implementation consultant determines that the ADDR_GENERIC_PC_CITY format is a 
close match to the address structure ManxComm needs. The consultant can use New-
From on the ADDR_GENERIC_PC_CITY format to create a new address format, then 
modify the components: one address line component needs to be deleted, and the 
postal code component needs to be modified. (See "Create a new address structured 
format" on page 48 and "Create a component" on page 58.)

Address Format components Example

<Building>
<Plot> <Thoroughfare>
<Town>
<Postcode>
<Country>

Douglas House
32 Ramsey Road
Castletown
IM 5EE
ISLE OF MAN

Rules regarding the postcode:

Write the postcode in block capital letters and never join the 
characters.

Do not use punctuation marks anywhere in the code.

Leave a clear space, equivalent to two characters, between the 
two parts of the code.

Never underline the postcode.

The postcode should always be the last item in the address, on a 
line by itself.

Never write anything below or to the right of the postcode.
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The Mapleleaf Tel scenario
Mapleleaf Tel is a Canadian provider that just purchased the MetaSolv Solution. They use 
all the ordering modules, including ASR and LSR. They also support North American 
Emergency Number Association (NENA) service and number portability. 

Implementation analysis regarding GATs and structured formats reveals the following 
information:

Appropriate GATs exist, but the hierarchy relating them needs to be built. For Canada, 
COUNTRY is parent to PROVINCE, and PROVINCE is parent to CITY. (See "Build a 
GAT hierarchy" on page 40 for instructions.)

Because Canada uses NENA, number portability, and PICs (primary interexchange 
carriers) the North American Functionality checkbox must be enabled for the country. 
(See "Activate a country" on page 38 for instructions.)

Mapleleaf Tel wants MSAG to be their default address structured format to 
accommodate their NENA compatibility. This means the following changes must be 
made:

Create a new address structured format using New-From on the system-defined 
MSAG format.

Remove the existing associated countries, and add Canada as an associated 
country, making it Primary so that this address format is the default for Canada. 
(See "Create a new address structured format" on page 48 and "Change the default 
structured format for a country" on page 42 for instructions.)

Change the STATE component in the following ways:

⇒ On the component’s General tab, change Component Name and Component 
Label to PROVINCE.

⇒ On the component’s Geographic Areas tab, remove the existing associated 
countries and click APPLY to update the database. Select PROVINCE in the 
Geographical Area Type drop-down, then select Canada from the Available 
Countries list and associate it by clicking the Assign button. (See "Create a 
Geographical Area component" on page 59 for instructions.)

Change the CITY and COUNTRY components in the following ways:

⇒ On both components’ Geographic Areas tab, remove the existing associated 
countries and click APPLY to update the database. Select Canada from the 
Available Countries list and associate it by clicking the Assign button. (See 
"Create a Geographical Area component" on page 59 for instructions.)

Determine GAT hierarchy
To determine whether there is an existing GAT hierarchy for a country, do the following:

1. Start MetaSolv Solutions Utility Application.

2. Click Options and select Geographical Area Types.

3. Double-click COUNTRY to open it.
1994-2001 MetaSolv Software, Inc. 35

MetaSolv confidential. All rights reserved. Information subject to change without notice.



Best Practices Guide Structured Formats
Creating Structured Formats MetaSolv Solution™ M/5
4. Click the GAT Relationships tab to open it. Look at the bottom pane. If the country 
appears in the Parent column of that pane, then a GAT hierarchy has been built for it, 
and you should continue to step 5. If the country does not appear in that pane, then 
the country is without a GAT hierarchy and you need to create a GAT hierarchy for it. 
(See "Build a GAT hierarchy" on page 40.)

5. Select the Country for which you are determining GAT hierarchy. For example, select 
the United States in the Parent column of the bottom window pane, then click the 
View button at the bottom of the window.

6. Double-click the globe icon to expand the hierarchy for the country.

7. If the subordinate level appears with a plus-sign, click the plus-sign to expland to the 
next level. Continue clicking plus-signs until you reach the level without a plus-sign. 
When the hierarchy is fully expanded (there are no more plus-signs to click), you can 
see how many levels are in it, and what each level is called. For example, as shown in 
Figure 14, there are a total of three levels for the United States: COUNTRY is first, 
STATE is second, and CITY is third.

Figure 14: GAT Hierarchy Fully Expanded
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Add a new GAT
If a country has a geographic area type that is not accommodated by the six system-defined 
GATs, you can add a new GAT. 

1. Start MetaSolv Solutions Utility Application.

2. Click Options and select Geographical Area Types.

3. Click New.

4. Enter a GAT name and description and click Apply. 

5. Click the GAT Country tab and move the country for which you are creating the new 
GAT to the Associated Countries list by selecting it and clicking the Assign button. 
Note that if the country you want to relate does not appear in the Available Countries 
list, click the Show Inactive Countries checkbox. If the country then appears, then you 
do not need to add it, but you do need to activate it. To activate the country, see 
"Activate a country" on page 38.

6. Click OK to complete addition of the new GAT. 

Add a new country
If a country does not appear in the list on the Country tab of the Geographic Area Type 
window, then you must add it as a new country. For example, in the scenario above for 
ManxComm, it was determined that the Isle of Man needed to be added as a new country. 
The procedure for adding a new country is explained below. 

1. Start MetaSolv Solutions Utility Application.

2. Click Options and select Geographical Area Types.

3. Double-click COUNTRY to open it.

4. Click the GAT Country tab to open it. 

5. Click the New button. The following window appears:

Figure 15: Country - New Window for Adding a New Country

6. Complete all fields on the Country—New window. While the Numeric Country Code, 
Three Character Country Code and the North American Functionality fields are not 
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required fields, they are extremely important fields. The Numeric Country Code is 
sometimes used for billing purposes, and it must be a unique identifier for the country. 
The Three Character Country Code should always be filled in, and the code should be 
based on ISO standard country codes. North American Functionality has implications 
across the software, some of which are:

Controls display of fields and tabs relevant to north American functionality such 
as: E911, PIC, CNAM, LIDB, LNP

Use of working telephone number (WTN) to determine local serving office (LSO) 
on a circuit design

Control over the structures that are needed for PSR API

PSR validations

7. The value you enter in the Country Instance Name field is the name that appears in 
Infrastructure for the country. You can use this field to localize the country name to 
the native language. For example, Spain would have a Country Instance Name of 
España.

8. Click OK to save the values and close the window. 

Activate a country
If you need to check (or change) a country’s settings regarding its Telephone Number 
Code, North American Functionality, Country Instance Name, or Active Indicator, do the 
following:

1. Start MetaSolv Solutions Utility Application.

2. Click Options and select Geographical Area Types.

3. Double-click COUNTRY to open it.

4. Click the GAT Country tab to open it. 

5. Select the country you want to activate from the Associated Countries pane. If the 
country does not appear, click the Show Inactive Countries checkbox. 

6. Click Open. The Country window appears. It is identical to the Country- New window 
shown above in Figure 15.

7. If the name of the country shown in the Country Instance Name field is not translated 
to the local language, you change it. The name that appears in this field is the name of 
the country that appears in Infrastructure. For example, you could enter a Country 
Instance Name of España for Spain.

8. If the Active Indicator is not checkmarked, click it to enable it.

9. If the Three Character Code is blank, fill it in with the correct ISO code.
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10. If the country employs North American Functionality, mark that checkbox. (See step 6 
in the preceding procedure for Add a new GAT to understand the implications of 
checkmarking North American Functionality.)

11. If you want to check whether a hierarchy was created for the country (perhaps you are 
activating a country that had had a hierarchy built previously) you can click the View 
button on the GAT Country tab.

12. Click OK to save and close the window. 

Create instances of a GAT
You should always add a few instances of each GAT after you build the GAT hierarchy so 
that you can fully test address structured formats. This is done through Infrastructure in 
the core product rather than through utilities. To add instances of each GAT in the 
hierarchy, do the following:

1. Start the MetaSolv Solution Software.

2. Click Infrastructure on the main menu.

3. Click List>Geo Areas.

4. Expand Geo Areas. 

5. Expand the country for which you are creating instances.

6. Right-click and select Add or Add New Child. The window shown in Figure 16 
appears. Add at least two instances of each GAT in the country’s hierarchy. 

Figure 16: Geographical Areas Maintenance Window in Infrastructure

Define users’ preferences
There are four preferences related to structured formats that should be defined for every 
user during implementation. Preferences determine structured format defaults in 
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accordance with the default hierarchy described in "How structured formats are 
employed" on page 8 of Chapter 2. The four preferences are shown in Figure 17.

Figure 17: User Preferences Settings Related to Structured Formats

Build a GAT hierarchy
Use the following procedure to create a hierarchy that relates the different GATs within a 
country. Note that relationships are always built from the top down; from the parent to the 
child.

1. Start the MetaSolv Solution Utility Application.

2. Select Options>Geographical Area Types from the main menu.

3. Open a GAT that is subordinate to the country level. For example, if you were building 
a hierarchy for the United States, you could open STATE or CITY.

4. Click the GAT Country tab. Look for the country for which you are building the 
hierarchy in the Available Countries list. If the country does not appear, click the 
Show Inactive Countries checkbox. 

5. Select the country whose hierarchy you are building in the Available Countries pane 
and click the Assign button (left-arrow) to move it to the Associated Countries pane. 

6. Repeat steps 1-5 for each GAT the country requires in its hierarchy. This process 
associates the GATs with the client’s country, which must be done before the GATs 
can be related to each other hierarchically. (Remember, Brazil and the United States 
are the only countries that have their GAT hierarchies pre-built, so you must complete 
this procedure for any country other than Brazil or the United States.)

7. After associating each GAT to the country, open the GAT that is the first level down 
from COUNTRY for the client’s country. For example, if you were building the 
hierarchy for the United States, you would open STATE.

Regardless of the 
order in which they 
are llisted, set the 
Country Default 
first, then set the 
Address Structure, 
Switch Prefix, and 
Telephone number 
Structured Format 
Defaults.
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8. Click the GAT Relationships tab.

Select the client’s country in the Parent Geographical Area Type pane.

Select the subordinate GAT for the country in the Child Geographical Area Type 
pane.

Click the Assign button to build the parent-child relationship. 

9. Repeat step 8 for each subordinate GAT level that needs to be related. You can only 
build the relationship from the top down; from the parent GAT to the child.

10. If the client prefers it, you can deactivate the countries they do not need. Deactivating 
countries simplifies what appears in the Infrastructure Geo Areas list. To deactivate a 
country, open the Countries tab, then open each country the client does not need and 
uncheck its Active checkbox. 

11. Add instances of each GAT for the country. This is done through Infrastructure in the 
core product rather than through utilities. You must have a few instances of each GAT 
to be able to test address structured formats that employ drop-downs based on GATs. 
To add instances of GATs, see the preceding procedure titled "Create instances of a 
GAT" on page 39.

Best practices regarding GATs

Always make sure you understand the GAT hierarchy for any country for which you 
are implementing structured formats. You must build the hierarchy for any country 
other than the United States and Brazil—those are the only two countries that are 
installed with system-defined GAT hierarchies. To build a GAT hierarchy, you must 
relate parent GATs to child GATs. 

Confirm that the country’s activation settings (Telephone Number Code, North 
American Functionality, Three Character Country Code, and Active Indicator) are 
absolutely correct. With the exception of the Active Indicator, you cannot change 
these settings after entering data without inactivating the country, then creating a new 
country, and any data entered under the old country cannot be migrated to the new 
country. 

Determine the default structured formats for a country
To determine the default structured formats for a given country, refer to: Table 6 on 
page 22, Table 7 on page 23, and Table 8 on page 23. If the country you are working with is 
not listed in those tables, then it does not have any default structured formats defined for it 
yet. See "Change the default structured format for a country" on page 42 for instructions on 
setting up default structured formats for a country. 

Determine structured formats that fit a client’s needs
To determine which structured formats fit a client’s needs, you must examine in detail the 
components of the ones you think might be right. This procedure assumes you have 
already completed a thorough analysis of the client’s needs, and that you have already 
1994-2001 MetaSolv Software, Inc. 41

MetaSolv confidential. All rights reserved. Information subject to change without notice.



Best Practices Guide Structured Formats
Creating Structured Formats MetaSolv Solution™ M/5
defined the components of their addresses, phone numbers, and switch prefixes. The 
components of the system-defined structured formats are listed in Table 6 on page 22.

However, you should examine the exact properties of the components, as explained in the 
following procedure, to ensure that they fulfill the client’s requirements. If none of the 
system-defined structured formats fulfill the client’s needs, see "Create a new address 
structured format" on page 48, "Create a new switch prefix structured format" on page 52, 
and "Create a new telephone number structured format" on page 54.

1. Start the MetaSolv Solution Utility Application.

2. Select Options from the main menu, then select Structured Formats>Structured 
Formats.

3. Double-click the structured format you want to examine.

4. Click the View button to see a preview of how the structured format looks in a data 
entry window, a query window, and as a built format in a display window. 

You must enter sample data in the Data Entry Display tab to see how the 
components work as fields. Note whether the drop-down fields display 
appropriate values. Entering sample data also allows you to check the sequence in 
which tabbing occurs from field to field.

Click the Query Display tab to see which components of the structured format are 
presented in a query.

Click the Built Structure Format tab to see how the components of the structured 
format look in a display window, and how they will be stored in the database.

5. Click the Components tab, and double-click the first component to open it. Examine 
each of the tabs that are highlighted and all the fields on each tab to determine if the 
component meets the client’s needs per your analysis of their requirements. See 
"Create a component" on page 58 for an explanation of each field on each tab of the 
Structured Format Components window. 

6. Close the Structured Formats Components window to return to the Structured Formats 
Maintenance window. 

7. Repeat steps 1-5 until all you have examined and understand the role and 
relationships of all components in the structured format.

Change the default structured format for a country
Use the following procedure when analysis of a client’s needs reveals that the default 
structured format (the Primary Indicator) for the country should be changed. 

1. Start the MetaSolv Solution Utility Application.

2. Select Options from the main menu, then select Structured Formats>Structured 
Formats.

3. Double-click the structured format that you want to assign as the new default format 
for the country.
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4. Click the Countries tab.

5. Check the Primary Indicator for the client’s country. When you do this, you receive a 
message telling you that the Primary Indicator is already set for that country on a 
different structured format. Make note of which structured format is stated in the 
message.

6. Close the Structured Format Maintenance window to return to the Structured Formats 
window.

7. Double-click the structured format that was stated in the message.

8. Click the Countries tab, and uncheck the Primary Indicator checkbox for the client’s 
country, then close the Structured Format Maintenance window.

9. Re-open the structured format you want to change the default to and click the 
Countries tab, then check the Primary Indicator checkbox for the country. The 
structured formats with the Primary Indicator checkmarked for a given country 
become the default structured formats for that country. Note, however, that the process 
the software goes through to determine which structured format to use at a given point 
is determined by the hierarchy defined in "How structured formats are employed" on 
page 8 of Chapter 2. 

Best practices regarding changing structured format defaults

When changing the Primary Indicator for a country, you must disable it on the 
existing structured format before you can enable it on a different structured format. 

If you are creating a new structured format, and it is the only one the customer will use 
for that type of format, be sure to enable the Primary Indicator. 

Always make sure that the Primary Indicator is enabled for the relevant country on 
the default structured format, for each structured format type and country that the 
client uses. For example, if the client uses different address structured formats for 
France, Netherlands, and Germany, make sure that France, Netherlands, and Germany 
are checkmarked as Primary on each country’s default address format. Never omit the 
Primary Indicator for a country that actively employs structured formats!

Modify an existing structured format
How much of an existing structured format you can modify varies with three factors:

Whether it is a system-defined structured format

Whether it is active

Whether it is in use (data has been stored using the format) 

There are several restrictions on how the components of the format can be changed once it 
is active and in use. However, prior to those two events, some changes can be made to how 
components appear and whether they can be used in a query. Modifying an existing 
structured format is the easiest customization you can do to accommodate a client’s 
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requirements, so it is worth investigating modifications prior to resorting to creating new 
structured formats.

If an existing structured format (either system-defined or custom-defined, but prior to use) 
has all the components the client needs, but the components do not appear in the linear or 
horizontal layout on the data entry window that the client wants, you can change that. You 
can also change the sequence in which tabbing occurs on a data entry window, and the 
labels of the components. You can change certain other properties of a component, such as 
whether it is a required field, whether it can be used as a search parameter, and whether it 
is stored by its abbreviation. Use the following procedures to affect the needed change.

Change component label
1. Open the structured format.

2. Open the component whose label you want to change.

3. Type the new label in the Component Label field. Note that when you change this, the 
label by which this field is identified in online help will no longer match the label you 
have just given the field (component).

4. Click OK to save and close the Structured Format Component window.

5. Click View to check the change.

6. Click OK to close the Preview Structured Format window. 

7. Click OK again to close the Structured Format Maintenance window.

Change component layout and tab sequence
1. Open the structured format.

2. Click View and print a copy of the Preview Structured Format window, then click OK 
to close the preview. If you cannot print the window, sketch a quick picture of it so 
that you can write important layout and tab sequence numbers on the picture. For 
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example, if you printed the preview of the ADDR_GENERIC_PC_CITY address format, 
it would look like this:

Figure 18: Preview of ADDR_GENERIC_PC_CITY Address Structured Format

3. Close the preview, then open each component and write the Display Line Number, 
Display Order value, and the Tab Order value next to the component as it appears on 
the preview window that you printed or sketched in step 2. Writing the display 
numbers and the tab sequence is the quickest way of figuring out how to change the 
layout. Refer to Figure 19 before proceeding to step 4. 
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Figure 19: How to Modify Component Layout

4. Change the Display Line Number to move the component up and down the window; 
change the Display Order value to move the component horizontally across the 
display line; change the Tab Order to change the sequence in which the tab key travels 
through the components on a data entry window. (Note that it will be much easier to 
change tab order if the components were originally created with several spaces 
between their Tab Order values. For more information about Tab Order, Display Line 
Number and Display Order, see "Create a component" on page 58.)

5. Click OK to save component changes.

6. Click View to check your changes. Enter sample data in the fields on the Data Entry 
Display tab so that you can test the tab order. You need sample data to see how the 
structured format looks on a display window, which is what you see on the Built 
Structure Format tab. Note that the built structure is based on the Line Number, Order 
In Format, Indent Value, Followed By Spaces, Followed By Blank Lines and 
Followed By Character fields of the component. The Display Line Number and 
Display Order have no effect on the built structure whatsoever; they control the data 

Write the Display Line Number, Display Order, and Tab 
Order from the General tab of the component on its 
corresponding field in the sketch or printout of the preview. 
Do this for each component/field on the preview. It is very 
helpful to have a visual reference to the existing layout 
before you try to change it. 

The Display Line 
Number defines where 
the component 
appears vertically on 
the data entry 
window. The Display 
Order defines where 
the component 
appears horizontally 
in the Display Line. 
The Tab Order 
defines, with a relative 
number, the sequence 
in which fields are 
accessed when the 
user presses the tab 
key to move from field 
to field. 

1, 1, 10
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entry display only. (Note: If geographical area-based drop-downs are empty, it is 
because no instances of geographical areas were entered into Infrastructure. See 
"Create instances of a GAT" on page 39 for instructions on adding instances of GATs.)

Change other properties of existing components
There are checkboxes at the bottom of the General tab on the Structured Format 
Component window, some of which can be changed for an existing structured format. The 
ones you can change are listed below, along with a description of their role.

Required. When enabled, the component becomes a required field on data entry 
windows, and its label appears in blue to signify that it is required. This property 
cannot be changed after the structured format is in use. 

Search By. When enabled, the component is available as a field on query windows 
that include the structured format as a query field. For example, the components 
House Nbr and Street Name have their Search By checkbox enabled on the North 
American Master Street Address Guide structured format, therefore they appear as 
fields on query windows, as shown in the sample window below. 

Figure 20: Effect of Enabling Search By Checkbox on a Component

Search Dropdown. When enabled, the component is included as a drop-down box on 
query windows that include the structured format as a query field. This checkbox is 
available for components derived from tables—components with a Component Type of 
Valid Value Drop Down, Table Driven Drop Down, or Geographical Area. For example, 
the fields City, Text, State, Postal Code, and Country in the window sample in Figure 
21 appear as drop-downs because those components have their Search Dropdown 
checkbox enabled on the address structured format named TEXT. Note that the 
description for the TEXT structured format is Address when format is basic text and 
that the description, rather than the name, is what appears in the drop-down. 

Because this query includes a field for a structured format (in 
this example, the North American Master Street Address Guide 
address format), and because the House Nbr and Street Name 
components have their Search By checkbox enabled on that 
structured format, they appear here as fields.
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Figure 21: Effect of Enabling Search Dropdown Checkbox on a Component

Search Required. When enabled, a value for the component must be specified in 
queries where its structured format is included. 

Store Abbreviations. When enabled, a component that derives its value from a table, 
and that includes an abbreviation, will have its abbreviation stored in its built 
structure. 

Create a new address structured format
There are two ways to create a new address structured format: New, or New-From. 
Deciding whether to use New or New-From depends on how similar the origin is to the 
structure your client requires. The following procedure explains how to create a new 
address structured format using either New or New-From:

1. Start the MetaSolv Solution Utility Application.

2. Select Options from the main menu, then select Structured Formats>Structured 
Formats.

3. Either select a system-defined address format and click New-From, or simply click 
New.

4. Select the Type, and enter a Name and a Description for the new format. The 
Description is what shows up in drop-downs, not the Name. You will activate (by 
enabling the Active checkbox) the new structured format after you add components.

5. Click Apply.

Note: The Description for a structured format, even on a system-defined structured 
format, can always be changed. This allows clients to control what appears in 
data entry windows where structured format drop-downs appear. For example, 
a Brazilian client might want to translate the system-defined address structured 
format from the English description of Address Format for Brazil to a 
Portuguese description. 
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6. Click the MetaSolv Solution Processes tab, an example of which is shown below.

Figure 22: MetaSolv Solution Processes Tab on a New Address Structured Format

7. Select the appropriate processes from the Available Active MetaSolv Solution 
Processes pane and click the Assign button to move them to the Associated processes 
pane. (If you used New-From, you inherit the associated processes from the original 
structured format.) To understand which processes should be related, please carefully 
consider the description of processes found in "Processes that can be associated with 
structured formats" on page 18. It is generally a good practice to use one address 
structured format for all processes that use address structures whenever possible. If 
there is a well-founded reason to relate certain processes but not others, then choose 
the processes carefully. 
1994-2001 MetaSolv Software, Inc. 49

MetaSolv confidential. All rights reserved. Information subject to change without notice.



Best Practices Guide Structured Formats
Creating Structured Formats MetaSolv Solution™ M/5
8. Click the Countries tab, an example of which is shown below. 

Figure 23: Countries Tab on a New Address Structured Format

9. Disassociate any countries inherited in a New-From that the client does not need by 
moving them from the Associated pane to the Available pane. 

10. Relate the client’s country to the new address format by selecting it and moving it from 
Available Countries to Associated Countries. If the country you want to relate does not 
appear in the Available Countries list, it is probably because it is inactive. To activate 
the country, see "Activate a country" on page 38. 

11. Click the Components tab.

Delete any components that were inherited in a New-From that are not relevant to 
the client’s address format. If a component has relationships to other components, 
you must do deletions from the lowest to the highest component in the 
relationship.

Open each component that was inherited in a New-From and make any necessary 
changes. See the section titled, "Create a component" on page 58 for an 
understanding of how to work with components.

Add new components by clicking the New button. See the section titled, "Create a 
component" on page 58 for instructions on creating new components.

12. Use the View button from the Structured Format Maintenance window to check that 
the components look and act the way you want them to in the structured format. You 
must enter sample data in the Data Entry Display tab to be able to view it in the Built 
Structure Format tab. If you need to make changes to the data entry layout or the built 
structure, it is helpful to print the previews. Make notes on the printed preview of the 
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data entry view regarding the Display Line, Display Order and Tab Order—these are 
the fields that define the data entry view. Make notes on the printed preview of the 
built structure regarding the Line Number, Order In Format, Indent Value, Followed 
By Spaces, Followed By Blank Lines and Followed By Character—these are the fields 
that define the built structure. You need to know what these are before you try to 
change them. 

13. You can review the Industry Versions tab, but there is no action required for defining 
industry version on structured formats—everything related to industry version is 
system-defined.

14. Return to the Detail tab and enable the Active checkbox to activate the structured 
format.

15. Enable the Primary Indicator if this is the structured format that should be used as the 
default for the country. If the country is already checkmarked as Primary on another 
address structured format, you must disable it there before you can enable it here. A 
structured format can be primary for several countries, but a country can only have 
one primary structured format per structured format type—one for address structured 
format, one for telephone number structured format, and one for switch prefix 
structured format.

16. Click OK to save the new format. 

Best practices regarding address structured formats

There are circumstances in which a client might need to employ multiple structured 
formats to accommodate multiple address formats. If the client elects to employ 
multiple structured formats, advise them of the complexities and possible 
performance degradation that kind of implementation might impose on querying 
activities. For clients who deal with multiple countries, the recommended approach to 
resolving the differing address formats is to define one structured format that is 
flexible and open enough to accommodate all the required countries’ address formats. 
However, the software does support different formats for different countries. 

Make every effort to define address formats that can endure through all foreseeable 
business needs, such as expanding business to new countries. It is not feasible to 
change to a new address structured format after data has been entered using the old 
structured format. There is no means of connecting the old data to the new data 
without a custom conversion effort.

Remember to enable the Primary Indicator for the country on the structured format 
that should be the default for the country. 

Once structured formats are used in the software and data is stored in the database 
according to those formats, they cannot be deleted. They can be deactivated, but they 
cannot be deleted. All data based on a deactivated structured format is preserved, but 
it cannot be migrated to a new format without a custom conversion effort. A 
deactivated structured format no longer appears as an option in a structured format 
drop-down, but it is still present within the software for the purpose of reviewing 
historical data that was stored using it. 
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Create a new switch prefix structured format
The procedure for creating a switch prefix structured format is explained below. Although 
the procedures in this chapter are not organized in a mandatory sequential order, in the 
case of switch prefix structured formats and telephone number structured formats, you 
must always create the switch prefix format before the telephone number format. 

There are two ways to create a new switch prefix structured format: New, or New-From. 
Deciding whether to use New or New-From depends on how similar the origin is to the 
structure your client requires. The following procedure explains how to create a new 
switch prefix structured format using either New or New-From:

1. Start the MetaSolv Solution Utility Application.

2. Select Options from the main menu, then select Structured Formats>Structured 
Formats.

3. Either select a system-defined switch prefix structured format and click New-From, or 
simply click New.

4. Select the Type, and enter a Name and a Description for the new format. You will 
activate (by enabling the Active checkbox) the new structured format after you add 
components.

5. Click Apply.

Note: You do not need a switch prefix structured format if the client does not 
inventory telephone numbers.

Note: The Description for a structured format, even on a system-defined structured 
format, can always be changed. This allows clients to control what appears in 
data entry windows where structured format drop-downs appear. 
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6. Click the MetaSolv Solution Processes tab, an example of which is shown below.

Figure 24: MetaSolv Solution Processes Tab on a Switch Prefix Structured Format

7. Select the INFRA500NA process from the Available Active MetaSolv Solution 
Processes pane and click the Assign button to move it to the Associated processes 
pane. (If you used New-From, you inherit the associated processes from the original 
structured format.) The INFRA500NA process is the only process that uses a switch 
prefix structured format. 

8. Click the Countries tab and disassociate any countries inherited in a New-From that 
the client does not need by moving them from the Associated pane to the Available 
pane. 

9. Associate the client’s country by selecting it and moving it from Available Countries to 
Associated Countries using the Assign button. 

10. Enable the Primary Indicator. If the country is already serving as the default on 
another structured format, you must disable it there before you can enable it here. A 
structured format can be primary for several countries, but a country can only have 
one primary structured format per structured format type—one for address structured 
format, one for telephone number structured format, and one for switch prefix 
structured format.

11. Click the Components tab and ensure that the inherited component(s) are correct, or 
create a new component(s). Typically, a non-North American switch prefix structured 
format has one or two components, and they are a Component Type of Table Driven 
Drop Down, with a Switches-to-Telephone Numbers relationship. Switch prefix 
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formats that employ typical North American functionality have two components and 
use the NPA-NXX tables. The critical aspects of a switch prefix component are: 

Its Component Type (Table Driven Drop Down).

Its Table Name and Column Name on the General tab.

Its Table Name and Column Name on the Table Driven Values tab. 

Its relationship to telephone number components. 

If you are unsure of how to define any of these critical items, refer to "Create a Table 
Driven Drop Down component" on page 66.

12. If there are characters that users should be prevented from entering into a switch 
prefix, enter those numbers on the Ineligible Characters tab of the affected component.

13. Use the View button from the Structured Format Maintenance window to check that 
the components look and act the way you want them to in the structured format. You 
must enter sample data in the Data Entry Display tab to view it in the Built Structure 
Format tab. 

14. Return to the Detail tab and enable the Active checkbox to activate the structured 
format.

15. Click OK to save the new format. 

Create a new telephone number structured format
The procedure for creating a telephone number structured format is explained below. 
Although the procedures in this chapter are not organized in mandatory sequential order, 
in the case of switch prefix structured formats and telephone number structured formats, 
you must always create the switch prefix format before the telephone number format. 

There are two ways to create a new telephone number structured format: New, or New-
From. Deciding whether to use New or New-From depends on how similar the origin is to 
the structure your client requires. The following procedure explains how to create a new 
telephone number structured format using either New or New-From:

1. Start the MetaSolv Solution Utility Application.

2. Select Options from the main menu, then select Structured Formats>Structured 
Formats.

Note: When you complete the telephone number structured format, you must return 
to the switch prefix structured format to create the switches-to-telephone 
numbers relationship. That relationship must be created in the switch prefix 
structured format, but it cannot be done until after the telephone number 
structured format is completed. 

Note: You do not need a telephone number structured format if the client does not 
inventory telephone numbers.
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3. Either select a system-defined telephone number structured format and click New-
From, or simply click New.

4. Select the type of structured format from the Type field, then enter a name and a 
description in the Name and Description fields. You will activate (by enabling the 
Active checkbox) the new structured format after you add components.

5. Click Apply.

6. Click the MetaSolv Solution Processes tab and select the INFRA500NA and the 
PSR500 processes from the Available Active MetaSolv Solution Processes pane and 
click the Assign button to move the selections to the Associated processes pane. (If you 
used New-From, you inherit the associated processes from the original structured 
format.) The INFRA500NA and PSR500 processes are the only process that use a 
telephone number structured format. 

7. Click the Countries tab and disassociate any countries inherited in a New-From that 
the client does not need by moving them from the Associated pane to the Available 
pane. 

8. Associate the client’s country by selecting it and moving it from Available Countries to 
Associated Countries. If the country you want to relate does not appear in the 
Available Countries list, it is probably because it is inactive. To activate the country, 
see "Activate a country" on page 38. 

9. Click the Components tab and ensure that the inherited component(s) are correct, or 
create a new component(s). Typically, a non-North American telephone number 
structured format has two components: one component for the switch prefix portion of 
the telephone number, and a second component for the line number portion of the 
telephone number. The critical aspects of a telephone number component are: 

Its type (Table Driven Drop Down for the switch prefix component, and Not 
Applicable for the line number component). 

Its Table Name and Column Name on the General tab. 

Its Table Name and Column Name on the Table Driven Values tab.

Its relationship to switch prefixes. 

If you are unsure of how to define any of these critical items, refer to "Create a Table 
Driven Drop Down component" on page 66 and "Add instances to the valid values 
table" on page 74.

10. Use the View button from the Structured Format Maintenance window to check that 
the components look and act the way you want them to in the structured format. You 

Note: The text in the Description field for a structured format, even on a system-
defined structured format, can always be changed. This allows you to control 
what appears in data entry windows where structured format drop-downs 
appear. 
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must enter sample data in the Data Entry Display tab to be able to view it in the Built 
Structure Format tab. 

11. If there are characters that users should be prevented from entering into a telephone 
number, enter those numbers on the Ineligible Characters tab of the affected 
component. 

12. Return to the Detail tab and enable the Active checkbox to activate the structured 
format.

13. Enable the Primary Indicator. If the country is already serving as the default on 
another address structured format, you must disable it there before you can enable it 
here. A structured format can be primary for several countries, but a country can only 
have one primary structured format per structured format type—one for address 
structured format, one for telephone number structured format, and one for switch 
prefix structured format.

14. Click OK to save the new format. 

Best practices regarding switch prefix and telephone number structured formats

There can be only one active switch prefix and one telephone number structured 
format per country.

The only process that employs switch prefix structured formats is INFRA500NA, and 
the only processes that employ telephone number structured formats are 
INFRA500NA and PSR500. 

If there are numbers or characters that should never be entered into a component of a 
switch prefix or telephone number, be sure to enter those numbers on the Ineligible 
Characters tab of the component.

You must relate processes, country, and components to the structured format before 
you can enable the Active checkbox, and you must enable the Active checkbox before 
you can enable the Primary Indicator for the country. 

You must create the switch prefix structured format first, then the telephone number 
structured format, then return to the switch prefix structured format to relate the 
switch prefix to the switch prefix component of the telephone number via the 
Switches-to-Telephone Numbers type of relationship. This relationship is required.

If the switch prefix component of the telephone number structured format should be 
used to filter another component of the telephone number (such as NPAs filter NXXs 
for United States telephone numbers), then a Component Relationship must be built 
on the telephone number structured format. The illustration in Figure 25 shows the 
relationship that can exist between a switch prefix structured format and a telephone 
number structured format, and the relationship that can exist between the components 

Note: When you complete the telephone number structured format, you must return 
to the switch prefix structured format to create the Switches-to-telephone 
numbers relationship. That relationship must be created in the switch prefix 
format, but it cannot be done until after the telephone number format is 
completed. 
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of a telephone number structured format. The graphic is based on a two-component 
type of switch prefix, such as NPA-NXX, and a three component telephone number 
format such as NPA-NXX-Line.

Figure 25: Switch Prefix and Telephone Number Structured Format Relationships

Telephone Number
Structured Format
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Structured Format

Component 1:
SP Area Code

(for example, NPA)

Component 2:
TN Exchange Code
(for example, NXX)

Component 1:
TN Area Code

(for example, NPA)

Component 3:
TN Line

Component 2:
SP Exchange Code
(for example, NXX)
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Switches-to-Telephone Number Relationship

There must be at least one 
Switches-to-Telephone 
Number relationship for the 
software to be able to make 
telephone number 
assignments. 
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Create a component
There are many properties that define a component, and they vary depending on the 
component type. The four types of components: 

Geographical Area

Table Driven Drop Down

Valid Value Drop Down

Not Applicable

Geographical Area and Valid Value components are only used in address structured 
formats. Table Driven Drop Down components are only used in switch prefix and 
telephone number structured formats. Not Applicable type components can be used in any 
type of structured format. A separate procedure for creating each type of component 
follows. 

Viewing the structured format as you create components

As you create components, remember to use the View button on the Structured Format 
Maintenance window frequently to check that the component looks and acts the way it 
should. The View button opens the Preview Structured Format window, on which there 
are three tabs, as shown in Figure 26. 

Figure 26: Preview Structured Format Window

If you fill in the fields of the Data Entry Display tab, you can see exactly how each 
component of the structured format appears in a data entry window, whether drop-downs 
are properly populated, and the tab sequence from field to field. On the Query Display tab, 
you can see which components of the structured format are included in a query, whether 
they are required, and whether they are drop-downs. On the Built Structure Format tab, 
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you see how the components of the structured format appear when built for display, 
including any indentation, spaces/characters following, and blank lines following.

Create a Geographical Area component
If the component you are creating is for an address structured format, and if it is the type of 
component you want to appear as a drop-down on a data entry display window with 
instances of a GAT populating the drop-down, then the component must have a 
Component Type of Geographical Area. Address structured formats are the only 
structured formats that use Geographical Area type components. Use the following 
procedure to create a Geographic Area type component.

To complete the General tab:

1. Open the structured format for which you are adding the new component. (You must 
create the structured format and assign a country to it before you can create 
components for it. See the section titled, "Create a new address structured format" on 
page 48 for instructions on creating a new structured format.)

2. Click the Components tab.

3. Click New. The General tab of the Structured Format Component window opens, a 
sample of which is shown in Figure 27. 

Figure 27: General Tab of a New Address Structured Format Component

4. Enter the Component Name. The Component Name is what appears in the list box on 
the Components tab of the structured format, and in drop-downs on query windows.

5. Enter the Component Label. The Component Label is what appears as the field name 
on windows where the component is employed.

6. Select the Component Data Type. It can be VARCHAR (numbers and letters), NUMBER 
(numbers only), or CHAR (letters only).

This is the default for 
a new component. 
You will change it to 
Geographical Area as 
you define the 
component. 
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7. Enter an Edit Mask if applicable for the component you are creating. An edit mask 
allows you to dictate what types of characters and how many go in which positions of 
the field when a user is entering it. For example, if the first characters of the field must 
always be two letters and the next four characters must be numbers, you would enter 
an edit mask of AA NNNN. Edit masks are most often used for postal codes in address 
structured formats. 

8. Select the Component Case. It can be Mixed, Upper or Lower. It is good practice to 
select Upper case for VARCHAR and CHAR data type components to simplify search 
strings.

9. Enter the maximum length that the component can be in the Component Length field. 
The value you enter here dictates the size of the field on data entry windows.

10. If appropriate for the component you are creating, enter a minimum length in the 
Minimum Length field. 

11. Enter the values in the fields that control appearance on the data entry display and in 
the built structure. The fields that control appearance in the data entry display are: 
Display Line Number, Display Order, and Tab Order. The fields that control 
appearance in the built structure are: Line Number, Order In Format, Indent Value, 
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Followed By Spaces, Followed By Blank Lines, and Followed By Character. Refer to 
Figures 28 and 29 for a full explanation of how these fields work.

Figure 28: Fields that Control Appearance on the Data Entry Display

The Display Line Number for the State component is 5, meaning the State 
field appears on the fifth line of the display. The Display Order is 1, 
meaning that the State field is the first field that appears on the fifth line. 
If you wanted to put the Town field following the State field on the same 
line, the Town component would have a Display Line Number of 5, and a 
Display Order of 2. 

The Tab Order number defines tab sequence relative to the other 
components’ Tab Order numbers. It is good practice to enter tab order 
numbers at least ten counts apart so that you can more easily change 
them if necessary after you have completed creating all the components. 
For example, suppose Street Name was Tab Order 1, and Street Number 
was Tab Order 2, and State was Tab Order 3. However, you decide it is 
actually easier for users to tab to State first, then tab to Street Name, then 
Street Number. Because you did not leave any relative space between the 
Tab Order numbers, you will have to change all three components’ Tab 
Order numbers to make State the first field in the tab order. Had you 
instead made Street Name’s Tab Order 10, Street Number’s Tab Order 20, 
and State’s Tab Order 30, you could have simply changed State’s Tab 
Order to 5 to make it the first field in the Tab Order. 

The effects of the 
values you enter for 
Display Line Number, 
Display Order, and Tab 
Order can be seen on 
the Data Entry Display 
tab of the Preview 
window. To open the 
Preview window, close 
the Structured Format 
Component window 
and click the View 
button on the 
Structured Format 
Maintenance window.

When Display Order is 
1, the value is left-
aligned with the other 
fields on the data entry 
display. If the Display 
Order is other than 1, 
but it is the only 
component on the 
display line, it will not 
be left-aligned.
1994-2001 MetaSolv Software, Inc. 61

MetaSolv confidential. All rights reserved. Information subject to change without notice.



Best Practices Guide Structured Formats
Creating Structured Formats MetaSolv Solution™ M/5
Figure 29: Fields that Control Appearance on the Built Structure

12. Select Geographical Area as the Component Type. You select this type of component 
for data entry fields that store their values in the address table. For that reason, the 
Table Name field defaults to address.

13. A Geographical Area Component Type is always a drop-down field, and the drop-
down is always populated with the instances of a particular GAT. 

14. Select the Column Name that identifies where the component should be stored in the 
address table. Select the obvious and appropriate Column Name for the component 
you are creating. For example, if you are creating a component for CITY, choose the 
ga_instance_city column name. However, what is appropriate is not always obvious. 

The effects of the 
values you enter for 
Line Number, Order in 
Format, and Indent 
Value can be seen on 
the Built Structure 
Format tab of the 
Preview window. To 
open the Preview 
window, close the 
Structured Format 
Component window 
and click the View 
button on the 
Structured Format 
Maintenance window.

The effects of the values you enter for Followed By Spaces, Followed 
By Blank Lines, and Followed By Character can be seen on the Built 
Structure Format tab of the Preview window, provided you enter 
sample data in the Data Entry Display tab first. Note that any spaces 
specified in the Followed By Spaces field will fall after any character 
specified in the Followed By Character field. Note also that you 
cannot specify a negative indent value in the Indent Value field. 
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For example, if you are creating a component for PROVINCE, and province is to the 
country the same as STATE is to the United States, you should chose 
ga_instance_state as the column name. The rule to follow is that if a Geographical 
Area-type component acts like state or city does in the United States, use the 
ga_instance_city and ga_instance_state column names; if the component acts like 
something new or different, use one of the four ga_instance_id_addr_gat_comp 
column names. There are a total of 27 column names to chose from, as follows:

15. Enable the Required checkbox if this component should be a required field (the field 
label displays in blue text) on data entry windows. 

16. Enable the Search By checkbox if this component should be included in query 
windows that include the structured format.

17. Enable the Search Dropdown checkbox if this component should be a drop-down on 
the query window. 

18. Enable the Search Required checkbox if this component should be a required 
parameter in a query.

Column Name Use For

addr_comp1 through comp16 Miscellaneous address line components

ga_instance_id_addr_gat_comp1 through 
comp4

Geographical Area type components other 
than CITY, COUNTRY, and STATE

addr_format_type Reserved for use by the regulated ordering 
module

ga_instance_id_country Geographical Area type component 
populated by instances of GAT COUNTRY

ga_instance_id_state Geographical Area type component 
populated by instances of GAT STATE or 
other GATs that are like STATE, such as 
PROVINCE

ga_instance_id_city Geographical Area type component 
populated by instances of GAT CITY or other 
GATs that are like CITY, such as VILLAGE

street_nbr Address component for street number

street_nm Address component for street name

street_suff Address component for street suffix 
(thoroughfare)
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19. Enable the Store Abbreviations checkbox if this component should be stored by its 
abbreviation rather than its full wording. For example, if you want to store 
abbreviations for the component STATE, then TEXAS would be stored as TX. This 
assumes that an abbreviation is required when entering instances of the GAT. 

20. Enable the Leading Zero Required if this component should be front-filled with zeros. 
For example, if the field is five characters long, and the value the user is entering is 1, 
they must enter it as 00001 if this checkbox is enabled. 

21. Enable the Dropdown checkbox if this component should be a drop-down type of 
field. This checkbox automatically enables when the value in the Component Type 
field is Table Driven Drop Down, Geographical Area, or Valid Value Drop Down. 

22. Enable the Prepend Label checkbox if this component should have its label added to 
the front of its data value in its built format. For example, if the Component Name is 
Building Number and the Component Label is Building, then enabling the Prepend 
Label checkbox prints the word Building in front of the value entered for Building. 
Hence, if the user enters 12 in the Building field of a data entry window, the built 
structure displays Building 12.

23. Enable the Active checkbox if this component is new and is ready for use in the 
structured format. A component can be deleted from a structured format before it is 
used ("used" means data has been written to the table and column designated by this 
component); it cannot be deleted after it is used. However, it can be inactivated. For 
example, if a component called Building was set up for an address structured format, 
but it was later deemed that capturing building as a separate component was 
differentiating the address into too much granularity, the Building component could 
be deactivated by removing the checkmark from the Active checkbox.

To complete the Geographical Area tab:

1. Click the Geographical Area tab to open it. An example of the tab is shown in Figure 
30.
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Figure 30: Geographical Area Tab on Structured Format Component Window

2. Select the GAT on which the component is based from the Geographical Area Type 
drop-down.

3. Select the Country from the Available Countries list.

4. Click the Assign button to move the two selections to the Associated Geographical 
Areas list.

5. Click Apply.

To complete the Relationships tab:

If there is a relationship between two geographical area components, that relationship is 
defined from the top down on the Relationships tab. For example, if you have a STATE 
component and a CITY component, STATE has a parent relationship to CITY. That 
relationship must be defined on the Relationships tab of the STATE component because 
STATE is the highest (top) level in the relationship. Note that the relationships between 
geographical area components must be identical in hierarchy to the relationships in the 
GAT hierarchy.

1. Open the Component that is the top level in the relationship you are creating.

2. Click the Relationships tab to open it. An example of the tab is shown in Figure 31.

Click the Assign button to move the 
two selections to the Associated 
Geographical Areas list. 

Select the Country 
second. 

Select the GAT first.
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Figure 31: Relationships Tab on Structured Format Component Window

3. Select the Relationship Type as Geo Area Hierarchy.

4. Select the child component from the Available Child Components list.

5. Click the Assign button to build the relationship. The built relationship is reflected in 
the Related Child Components list. Whenever you see an item in the Related Child 
Components list, there is an existing relationship. 

6. Click OK to save and close the window. 

Create a Table Driven Drop Down component
If the component you are creating is for a switch prefix or telephone number structured 
format, and if you want it to appear as a drop-down on a data entry window with instances 
of switch prefixes populating the drop-down, then the component must have a Component 
Type of Table Driven Drop Down. Use the following procedure to create a Table Driven 
Drop Down component.

To complete the General tab:

1. Open the structured format for which you are adding the new component. (You must 
create the structured format and assign a country to it before you can create 
components for it. (See the section titled, "Create a new switch prefix structured 
format" on page 52 or "Create a new telephone number structured format" on page 54 
for instructions on creating a new structured format.)

2. Click the Components tab.

"This parent component is being related...

...to this child component on the basis of the
Relationship Type above...

...and the built relationship appears down here
after I click the Assign button."

When you build 
relationships, it is 
helpful to read the 
Relationships tab like 
this: "I am relating the 
component in the title 
bar as a parent to the 
component in the 
Available Child 
Components list, on the 
basis of the relationship 
type I’ve selected in the 
Relationship Type 
drop-down. After I click 
the Assign button, I will 
see the built 
relationship in the 
Related Child 
Components list."
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3. Click New. The General tab of the Structured Format Component window opens, a 
sample of which is shown in Figure 32. 

Figure 32: General Tab of a New Switch Prefix Structured Format Component

4. Enter the Component Name. The Component Name is what appears in the list box on 
the Components tab of the structured format, and in drop-downs on query windows.

5. Enter the Component Label. The Component Label is what appears as the field name 
on windows where the component is employed.

6. Select the Component Data Type. For a Table Driven Drop Down type of component, 
the Component Data Type is typically NUMBER.

7. If applicable, enter an Edit Mask for the component you are creating. An edit mask 
allows you to dictate what types of characters and how many go in which positions of 
the field when a user is entering it. For example, if the first characters of the field must 
always be two letters and the next four characters must be numbers, you would enter 
an edit mask of AA NNNN.

8. Enter the maximum length that the component can be in the Component Length field. 
The value you enter here dictates the size of the field on data entry windows.

9. If appropriate for the component you are creating, enter a minimum length in the 
Minimum Length field. 

10. Enter the values in the fields that control appearance on the data entry display and the 
built structure. For assistance with these fields, refer to Figures 28 and 29 in "Create a 
Geographical Area component" on page 59. 
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11. Enter values in the From Range and To Range fields to specify a finite range of 
numbers that can be entered into this component. These range fields are intended 
primarily for line range on telephone numbers, although there are other components 
that might require ranges. Ranges can only be entered when the Component Data Type 
is NUMBER or VARCHAR. 

12. Select Table Driven Drop Down as the Component Type. You select this type of 
component for data entry fields that will both store and retrieve their values from 
tables related to switch prefixes and telephone numbers. When you specify the 
Component Type as Table Driven Drop Down, you are also specifying that the 
component is a drop-down field, and that the drop-down is populated with instances 
from a particular switch prefix table and column. 

13. Select the Table Name. If you are creating a component for a structured format that 
does not retrieve or store its values in the NPA-NXX tables, then select ni_nbr_itn. If 
the component does store values in the NPA-NXX tables, select the npa_nxx table. 

14. Select the Column Name that identifies where you want the component stored in the 
table. Select the next available column name if the component is being stored in the 
ni_nbr_itn table. Select npa or nxx if you want the component stored in the npa_nxx 
table.

15. Enable checkboxes at the bottom of the tab appropriately for the component you are 
creating. For definitions of those checkboxes, see "Create a Geographical Area 
component" on page 59.

To complete the Table Driven Values tab:

1. Click the Table Driven Values tab to open it. An example of the tab is shown in Figure 
33.
68 1994-2001 MetaSolv Software, Inc.
Information subject to change without notice. MetaSolv confidential. All rights reserved.



Structured Formats Best Practices Guide
MetaSolv Solution™ M/5 Creating Structured Formats
Figure 33: Geographical Area Tab on Structured Format Component Window

2. Click New to open the MetaSolv Solution Table Name and MetaSolv Solution Column 
Name drop-downs. 

3. Select the appropriate MetaSolv Solution Table Name and the MetaSolv Solution 
Column Name from the drop-downs. Making the appropriate selections here requires a 
fundamental understanding of the MetaSolv Solution data model. The selections you 
make here determine what appears in the component drop-down on the data entry 
display window. 

4. Click the Apply button to save your selections. 

To complete the Relationships tab:

If there is a Switches-to-telephone Numbers or a Component Hierarchy relationship 
between two table driven drop down components, that relationship is defined on the 
Relationships tab of the highest level component (top-down). For example, if you have an 
AREA CODE component on a switch prefix structured format that needs to be associated 
with an AREA CODE component on a telephone number structured format by way of the 
Switches-to-Telephone Numbers relationship type, then that relationship must be defined 
on the Relationship tab of the switch prefix component. 

The switch prefix AREA CODE component is the top (parent) and the telephone number 
AREA CODE is the child in the Switches-to-Telephone Numbers relationship. If an AREA 
CODE on either a telephone number or switch prefix structured format needs to be 
associated with an EXCHANGE CODE on the same structured format, that is a Component 
Hierarchy type relationship. That type of relationship is also defined on the Relationships 
tab of the highest level (parent) component in the relationship. 

1. Open the Component that is the top-level in the relationship you are creating.

You must first click the New button to get the Table 
and Column Name drop-downs to appear. 

The column name you 
select here is the column 
within the table from 
which values are retrieved 
to populate the drop-down 
field of the component you 
are defining.

The table name you 
select here is the table 
from which values are 
retrieved to populate 
the drop-down field of 
the component you are 
defining. 
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2. Click the Relationships tab to open it. An example of the tab is shown in Figure 31 
"Relationships Tab on Structured Format Component Window" on page 66.

Figure 34: Relationships Tab on Structured Format Component Window

3. Select the Relationship Type. Refer to Figure 25 "Switch Prefix and Telephone 
Number Structured Format Relationships" on page 57 for an understanding of the 
difference between Component Hierarchy and Switches-to-Telephone Numbers 
relationship types.

4. Select the child component from the Available Child Components list. (This list does 
not populate until you select the Relationship Type.)

5. Click the Assign button to build the relationship. The built relationship is reflected in 
the Related Child Components list. Whenever you see an item in the Related Child 
Components list, there is an existing relationship. 

6. Click Apply to save the changes. 

"This parent component is being related...

...to this child component on the
basis of the Relationship Type
above...

...and the built relationship appears down here
after I click the Assign button."

When you build 
relationships, it is 
helpful to read the 
Relationships tab like 
this: "I am relating the 
component in the title 
bar as a parent to the 
component in the 
Available Child 
Components list, on the 
basis of the relationship 
type I’ve selected in the 
Relationship Type drop-
down. After I click the 
Assign button, I will see 
the built relationship in 
the Related Child 
Components list."
70 1994-2001 MetaSolv Software, Inc.
Information subject to change without notice. MetaSolv confidential. All rights reserved.



Structured Formats Best Practices Guide
MetaSolv Solution™ M/5 Creating Structured Formats
Create a Valid Value Drop Down component
Valid values are pre-defined for thoroughfares (Street, Avenue, Blvd., and so forth) and 
compass points (N., E., W., S, SW., and so forth). Users can also add to the valid values 
table through both the MetaSolv Utility and the core product. If the component you are 
creating is for an address structured format, and if you want the component to appear as a 
drop-down on a data entry display window populated with instances from the valid 
values table, then the component must have a Component Type of Valid Value Drop 
Down. Use the following procedure to create a Valid Value Drop Down type component.

To complete the General tab:

1. Open the structured format for which you are adding the new component. (You must 
create the structured format and assign a country to it before you can create 
components for it. See the section titled, "Create a new address structured format" on 
page 48 for instructions on creating a new structured format.)

2. Click the Components tab.

3. Click New. The General tab of the Structured Format Component window opens, a 
sample of which is shown in Figure 35. 

Figure 35: General Tab of a New Address Structured Format Component

4. Enter the Component Name. The Component Name is what appears in the list box on 
the Components tab of the structured format, and in drop-downs on query windows.

5. Enter the Component Label. The Component Label is what appears as the field name 
on windows where the component is employed.

6. Select the Component Data Type. For a Valid Value Drop-Down type of component, 
the Component Data Type is typically VARCHAR.
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7. Enter the maximum length that the component can be in the Component Length field. 
The value you enter here dictates the size of the field on data entry windows.

8. If appropriate for the component you are creating, enter a minimum length in the 
Minimum Length field. 

9. Enter the values in the fields that control appearance on the data entry display and in 
the built structure. For assistance with these fields, refer to "Create a Geographical 
Area component" on page 59. 

10. Select Valid Values Drop Down as the Component Type. You select this type of 
component for data entry fields that store their values in the address table, and that 
populate their drop-downs from the valid value table. 

11. Select an appropriate Column Name. For example, if you are setting up a component 
for THOROUGHFARE, the appropriate column name would be street_suf. If you are 
setting up a component for compass direction associated with a street number or 
name, the appropriate column name would be addr_comp1 (or the next available 
number, such as addr_comp2, or addr_comp3).

12. Enable checkboxes at the bottom of the tab appropriately for the component you are 
creating. For definitions of those checkboxes, see "Create a Geographical Area 
component" on page 59.

To complete the User Defined Values tab:

1. Click the User Defined Values tab to open it. An example of the tab is shown in Figure 
36.

Figure 36: User Defined Values Tab on Structured Format Component Window
72 1994-2001 MetaSolv Software, Inc.
Information subject to change without notice. MetaSolv confidential. All rights reserved.



Structured Formats Best Practices Guide
MetaSolv Solution™ M/5 Creating Structured Formats
2. Select the valid values you want to appear in the component’s drop-down from the 
Available Valid Values list. You can use Shift+click and Ctrl+click to make 
contiguous and non-contiguous selections. 

3. Click the Assign button to move the selections to the Associated Valid Values list.

4. Click the Apply button to save your selections. 

Relate a valid value to a provider

Valid values can be associated with a specific provider using the provider’s Interexchange 
Customer Service Center (ICSC) code. For example, if a client sends ASRs to a provider 
who only accepts three-character street suffixes on service location addresses (they accept 
AVE but reject AV) then that provider’s ICSC can be associated with the three-character 
street suffixes, thus ensuring ASRs are not entered with values that will be rejected by the 
provider. You associate the accepted valid values to the ICSC on the User Defined Values 
tab. This functionality is only relevant to the OBF_SRVC_ADDR structured format.

1. Select the valid values from the Associated Valid Values list that you want to associate 
with a specific ICSC. You can use Shift+click and Ctrl+click to make contiguous and 
non-contiguous selections.

2. Click the preview button to open the Associate Providers with Structured Format 
Component Valid Values window, shown in Figure 37.

Figure 37: Associate Providers with Structured Format Component Valid Value

Note: As indicated on the window, the only way to remove a valid value after it has 
been associated and saved is to inactivate it. To inactivate, simply remove the 
checkmark in the valid value’s Active checkbox. 
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3. Click OK to close the window and save the associations. 

Add instances to the valid values table

To add instances to the valid values table, you can go through Infrastructure in the core 
software, or you can use the MetaSolv Utility. To add instances through Infrastructure, 
select Infrastructure>List>Structured Formats>Valid Values, then right-click and select 
New. To add instances through the MetaSolv Utility, select Options>Structured 
Formats>Valid Values, then right-click and select New. 

Create a Not Applicable (plain) component
If the component you are creating is an editable field rather than a drop-down that 
retrieves its values from a table, then the component must have a Component Type of Not 
Applicable. Address and telephone number structured formats are the only structured 
formats that use Not Applicable type components. Use the following procedure to create a 
Not Applicable type component.

To complete the General tab:

1. Open the structured format for which you are adding the new component. (You must 
create the structured format and assign a country to it before you can create 
components for it. See the section titled, "Create a new address structured format" on 
page 48 for instructions on creating a new structured format.)

2. Click the Components tab.

3. Click New. The General tab of the Structured Format Component window opens. 

Note: The procedure above can also be done within Infrastructure, once the 
component is created. To do the procedure from Infrastructure, click 
List>Structured Formats>Components, then search to the component for which 
you want to relate valid values. Open the component, click the User Defined 
Values tab, then proceed as described above, starting with step 1.
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Figure 38: General Tab of a New Address Structured Format Component

4. Enter the Component Name. The Component Name is what appears in the list box on 
the Components tab of the structured format, and in drop-downs on query windows.

5. Enter the Component Label. The Component Label is what appears as the field name 
on windows where the component is employed.

6. Select the Component Data Type. It can be VARCHAR (numbers and letters), NUMBER 
(numbers only), or CHAR (letters only).

7. Enter an Edit Mask if applicable for the component you are creating. An edit mask 
allows you to define what types of characters and how many go in which positions of 
the field when the user is entering it. For example, if the first characters of the field 
must always be two letters and the next four characters must be numbers, you would 
enter an edit mask of AA NNNN. 

8. Select the Component Case. It can be Mixed, Upper or Lower. It is good practice to 
select Upper case for VARCHAR and CHAR data type components to simplify search 
strings.

9. Enter the maximum length that the component can be in the Component Length field. 
The value you enter here dictates the size of the field on data entry windows.

10. If appropriate for the component you are creating, enter a minimum length in the 
Minimum Length field. 

11. Enter the values in the fields that control appearance on the data entry display and in 
the built structure. The fields that control appearance in the data entry display are: 
Display Line Number, Display Order, and Tab Order. The fields that control 
appearance in the built structure are: Line Number, Order In Format, Indent Value, 
1994-2001 MetaSolv Software, Inc. 75

MetaSolv confidential. All rights reserved. Information subject to change without notice.



Best Practices Guide Structured Formats
Creating Structured Formats MetaSolv Solution™ M/5
Followed By Spaces, Followed By Blank Lines, and Followed By Character. Refer to 
Figures 28 and 29 for a full explanation of how these fields work.

12. Enter values in the From Range and To Range fields to specify a finite range of 
numbers that can be entered into this component. These range fields are intended 
primarily for line range on telephone numbers, although there are other components 
that might require ranges. Ranges can only be entered when the Component Data Type 
is NUMBER or VARCHAR. 

13. Select the Not Applicable Component Type. You select this type of component for 
data entry fields that entered and editable by the user (as opposed to data entry fields 
that are drop-down populated by table values). 

14. Select the appropriate Table Name. The Table Name identifies where the value the 
user enters is stored. 

15. Select the appropriate Column Name. The Column Name identifies which column in 
the table stores the component’s value when the user enters it. 

16. Enable the Required checkbox if this component should be a required field (the field 
label displays in blue text) on data entry windows. 

17. Enable the Search By checkbox if this component should be included in query 
windows that include the structured format.

18. Enable the Search Dropdown checkbox if this component should be a drop-down on 
the query window. 

19. Enable the Search Required checkbox if this component should be a required 
parameter in a query.

20. Enable the Store Abbreviations checkbox if this component should be stored by its 
abbreviation rather than its full wording. 

21. Enable the Leading Zero Required if this component should be front-filled with zeros. 
For example, if the field is five characters long, and the value the user is entering is 1, 
she must enter it as 00001 if this checkbox is enabled. 

22. Enable the Dropdown checkbox if this component should be drop-down type of field. 
This checkbox automatically enables for Table driven, Geographical Area, and Valid 
Value Drop Down Component Types. 

23. Enable the Prepend Label checkbox if this component should have its label added to 
the front of its data value in its built format. For example, if the Component Name was 
Building Number and the Component Label was Building, enabling the Prepend Label 
checkbox would print the word Building in front of the value entered for Building. If 
the user entered 12 in the Building field, the built structure would read Building 12.

24. Enable the Ranged checkbox if this component should be ranged between the numbers 
specified in the From Range and To Range values. The component must have a 
Component Data Type of NUMBER or VARCHAR to be eligible for ranging. 
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25. Enable the Active checkbox if this component is new and is ready for use in the 
structured format. A component can be deleted from a structured format before it is 
used ("used" means data has been written to the table and column designated by this 
component); it cannot be deleted after it is used. However, it can be inactivated. For 
example, if a component called Building was set up for an address structured format, 
but it was later deemed that capturing building as a separate component was 
differentiating the address into too much granularity, the Building component can be 
deactivated by removing the checkmark from the Active checkbox.
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To complete the Ineligible Characters tab:

If there are certain characters that users should be prevented from entering into the field, 
you identify those characters on the Ineligible Characters tab as follows:

1. Click the Ineligible Characters tab to open it. An example of the tab is shown in Figure 
39.

Figure 39: Geographical Area Tab on Structured Format Component Window

2. Click New and enter the ineligible character. If there are other characters, repeat this 
step until all those characters are entered. 

3. Click OK to save the ineligible characters list. 

To complete the Relationships tab:

If there is a relationship between this component and another component, you can define 
that relationship on the Relationships tab.

1. Open the Component that is the top level in the relationship you are creating.

2. Click the Relationships tab to open it.

3. Select the Relationship Type.

4. Select the child component from the Available Child Components list.

5. Click the Assign button to build the relationship. The built relationship is reflected in 
the Related Child Components list. 
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List of best practices for creating structured formats

Best practices regarding GATs

Make sure you understand the GAT hierarchy for any country for which you are 
implementing structured formats. You must build the hierarchy for any country other 
than the United States and Brazil—those are the only two countries that are installed 
with system-defined GAT hierarchies. To build a GAT hierarchy, you must relate 
parent GATs to child GATs. 

Confirm that the country’s activation settings (Telephone Number Code, North 
American Functionality, Three Character Country Code, and Active Indicator) are 
absolutely correct. With the exception of the Active Indicator, you cannot change 
these settings after entering data without inactivating the country, then creating a new 
country, and any data entered under the old country cannot be migrated to the new 
country. 

Best practices regarding changing structured format defaults

When changing the Primary Indicator for a country, you must disable it on the 
existing structured format before you can enable it on a different structured format. 

If you are creating a new structured format, and it is the only one the customer will use 
for that type of format, be sure to enable the Primary Indicator. 

Always make sure that the Primary Indicator is enabled for the relevant country on 
the default structured format, for each structured format type and country that the 
client uses. For example, if the client uses different address structured formats for 
France, Netherlands, and Germany, make sure that France, Netherlands, and Germany 
are checkmarked as Primary on each country’s default address format. Never omit the 
Primary Indicator for a country that actively employs structured formats!

Best practices regarding address structured formats

There are circumstances in which a client might need to employ multiple structured 
formats to accommodate multiple address formats. If the client elects to employ 
multiple structured formats, advise them of the complexities and possible 
performance degradation that kind of implementation might impose on querying 
activities. For clients who deal with multiple countries, the recommended approach to 
resolving the differing address formats is to define one structured format that is 
flexible and open enough to accommodate all the required countries’ address formats. 
However, the software does support different formats for different countries. 

Make every effort to define address formats that can endure through all foreseeable 
business needs, such as expanding business to new countries. It is not feasible to 
change to a new address structured format after data has been entered using the old 
structured format. There is no means of connecting the old data to the new data 
without a custom conversion effort.

Remember to enable the Primary Indicator for the country on the structured format 
that should be the default for the country. 
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Once structured formats are used in the software and data is stored in the database 
according to those formats, they cannot be deleted. They can be deactivated, but they 
cannot be deleted. All data based on a deactivated structured format is preserved, but 
it cannot be migrated to a new format without a custom conversion effort. A 
deactivated structured format no longer appears as an option in a structured format 
drop-down, but it is still present within the software for the purpose of reviewing 
historical data that was stored using it. 

Best practices regarding switch prefix and telephone number structured formats

There can be only one active switch prefix and one telephone number structured 
format per country.

The only process that employs switch prefix structured formats is INFRA500NA, and 
the only processes that employ telephone number structured formats are 
INFRA500NA and PSR500. 

Once a switch prefix or telephone number structured format is associated with a 
country that uses North American Functionality, those structured formats cannot be 
associated with a countries that do not use North American Functionality. Therefore, 
you should not create a switch prefix or telephone number structured format using 
New-From and try to associate it to a country that does not have the same North 
American Functionality setting as the country associated with the structured format 
used as the origin in the New-From.

If there are numbers or characters that should never be entered into a component of a 
switch prefix or telephone number, be sure to enter those numbers on the Ineligible 
Characters tab of the component.

You must relate processes, country, and components to the structured format before 
you can enable the Active checkbox, and you must enable the Active checkbox before 
you can enable the Primary Indicator for the country. 

You must create the switch prefix structured format first, then the telephone number 
structured format, then return to the switch prefix structured format to relate the 
switch prefix to the switch prefix component of the telephone number via the 
Switches-to-Telephone Numbers type of relationship. This relationship is required.

If the switch prefix component of the telephone number structured format should be 
used to filter another component of the telephone number (such as NPAs filter NXXs 
for United States telephone numbers), then a component relationship must be built on 
the telephone number structured format. The illustration in Figure 25 on page 57 
shows the type of relationship that can exist between a switch prefix structured format 
and a telephone number structured format, and the relationship that can exist between 
the components of a telephone number structured format. The graphic is based on a 
two-component type of switch prefix, such as NPA-NXX, and a three component 
telephone number format such as NPA-NXX-Line.
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This chapter is about using structured formats on a daily basis as data is entered into the 
software. It is intended primarily for users of the MetaSolv Solution, however 
implementers can also benefit from reading the information in this chapter. If you fully 
understand how structured formats are used, you are better able to understand how to set 
them up correctly during implementation. For example, if you work with the users of the 
affected windows to learn the order in which they prefer to enter field data, you then know 
the tab order in which to sequence the components of a structured format. 

Using address structured formats
Using address structured formats is simple and straightforward: on the windows where 
structured formats are employed, users see drop-downs for Country and Format. Ideally, 
user preferences have been defined that cause these drop-downs to default to the 
appropriate selection for the user, thus allowing them to skip having to make a selection. 
However, if the implementation supports multiple countries and address formats, then the 
user needs to make appropriate selections from the Country and Format drop-downs. 

Figure 40: Address Structured Format Driving Address Entry in PSR

Note that the structured 
format’s description appears 
in the drop-down rather than 
its name. The name of this 
format is ADDR_BR, however 
users don’t need to know the 
name. Implementers should 
be aware when they create or 
modify the descriptions that 
the description is what the 
user sees. 
1994-2001 MetaSolv Software, Inc. 81

MetaSolv confidential. All rights reserved. Information subject to change without notice.



Best Practices Guide Structured Formats
Using Structured Formats MetaSolv Solution™ M/5
In Figure 40, you see one example of an address structured format being employed in a 
PSR window. In this example, the Country is Brazil and the Format is Address format for 
Brazil. If preferences were set for the country to default to Brazil and the address 
structured format to default to ADDR_BR, then Brazil and Address format for Brazil would 
have automatically appeared in the two fields when the user opened the Address 
Maintenance window from the PSR order. If the preferences were not set, then the user 
would have to select the Country, then select the Format. The countries from which the 
user could select depends on the countries that are activated for the implmentation, and 
the formats the user could select depend on the address structured formats that are 
associated with the selected country. 

Figure 41: Address Structured Format Driving Query for End User Location

In Figure 41, you see an example of an address structured format being employed in a 
query window. As explained above, if preferences are set, the Country and Format fields 
would default. The other fields of the address format that appear on the query window 
depend on how the components of the structured format were defined.

There are many more windows that employ address structured formats, and the examples 
in Figures 40 and 41 are exemplary of how all of them work. Understanding how users see 
and complete structured formats in a data entry window should factor heavily into how 
you define them during implementation. Understanding when and how users query for 
data that includes the fields of a structured format also helps you determine how to define 
the required and query properties of the components in a structured format. 
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Using switch prefix structured formats
Using switch prefix structured formats is as straightforward as using address formats. On 
the windows where switch prefixes are employed, users simply select the appropriate 
values from the Format and Country drop-downs. Ideally, user preferences for country 
and switch prefix structured formats are defined so that these drop-downs default to the 
appropriate selections for the user. However, if the client supports multiple countries, 
users will need to make appropriate selections from the Country and Format drop-downs. 
The following windows are a few examples of windows in which users encounter Country 
and Format fields: 

Figure 42: Switch Prefix Structured Format Driving a Query in Infrastructure

Figure 43: Switch Prefix Structured Format Driving Switch Prefix Entry in Infrastructure
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Using telephone number structured formats
Using telephone number structured formats is as straightforward as using switch prefix 
formats. On the windows where telephone numbers are employed, users simply select the 
appropriate value from the Country drop-down. Ideally, user preferences are defined so 
that this drop-down defaults to the appropriate country. However, if the client supports 
multiple countries, users will need to make an appropriate selection from the Country 
drop-down. Note that the value that appears in the Telephone Number Format drop-down 
field defaults based on the value entered (or defaulted) in the Country field. Because it is 
dependent on country, and because there can be only one active telephone number 
structured format for a country, the Telephone Number Format field is grayed-out. The 
following window is one example of a window in which users might need to select 
Country: 

Figure 44: Telephone Number Structured Format Driving Telephone Number Query

Best practices for using structured formats
Make certain user preferences for structured formats are defined. 

If the client supports multiple countries, and multiple address structured formats, 
make certain users select the correct country and format for the data they are entering. 

If the order in which users tab to fields on a data entry window driven by a structured 
format is cumbersome, they should bring the problem to the attention of their 
MetaSolv Software implementation team.
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MetaSolv Customer Support helps report, track, and resolve issues relating to the 
MetaSolv Solution product line. The following table details the various ways you can 
contact Customer Support: 

Method Number/Address Special Notes/Procedures

E-mail techsupport@metasolv.com The customer must be a known 
MetaSolv software end-user whose e-
mail address has been entered into the 
Customer Support system.

When a customer sends an e-mail to the 
system, an automated e-mail response, 
with a service request number, is 
automatically sent to the customer.

See “Guidelines for e-mailing Customer 
Support” on page 86.

See “What information will Customer 
Support need?” on page 86.

Telephone 
Hotline

Toll Free: 888-884-7686

Voice: 972-403-8400

Toll-free hotline staffed Monday 
through Friday, 7 A.M.to 6 P.M. CT.

All severity 1 requests must be reported 
via the telephone hotline.

A voice response system provides 
instructions for reporting requests. 

See “Guidelines for e-mailing Customer 
Support” on page 86.

See “What information will Customer 
Support need?” on page 86.

Fax 972-403-8333
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Guidelines for e-mailing Customer Support
When you submit a request via e-mail, specify in the subject line one of the following 
product types in the subject line followed by a colon, space, and the subject of your 
request:

Background Processor

DB/UPGD/Install

Engineering

Gateway

Ordering

Security

Tools

Trouble

Work Mgmt

For example, to submit a problem for a gateway-related problem about the network 
provisioning indicator, your subject line will be Gateway: Network provisioning indicator 
is not working properly.

What information will Customer Support need?
Please be at your computer with the following information when you call:

The product version number, which is found by choosing Help>About MetaSolv 
Solution from the main menu in the MetaSolv software product family.

A printout of the system properties. To obtain the printout:

Mail MetaSolv Software, Inc.
Customer Support 
5560 Tennyson Parkway
Plano, TX 75024

Internet support.metasolv.com 1. Click Click here to continue.

2. Enter user ID and password.

3. Click Submit new customer support 
ticket. Fill out information as required.

4. Click Submit this information as a 
service request.

Warning: If you do not follow the exact spelling and format in the subject line, your 
e-mail cannot be processed by the automatic system and it will be sent back 
to you.

Method Number/Address Special Notes/Procedures
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1. Select Help>About MetaSolv Solution from the main menu.

2. Click the System Properties button.

3. In the System Properties window, click all the pluses to expand the hierarchy.

4. Click the Print button.

Exact wording of any messages that appear on your screen.

The window name where the problem occurred. Press Ctrl+W to determine the 
window name, which you can find in the lower, left corner of your screen on the status 
bar. The window name starts with w_.

What you were doing when the problem occurred.

How you tried to solve the problem.

Whether the problem is reproducible.
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